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Errata
The IC-CAP product may contain references 
to “HP” or “HPEESOF” such as in file names 
and directory names. The business entity 
formerly known as “HP EEsof” is now part 
of Agilent Technologies and is known as 
“Agilent EEsof.” To avoid broken functional-
ity and to maintain backward compatibility 
for our customers, we did not change all the 
names and labels that contain “HP” or 
“HPEESOF” references.
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Installing IC-CAP 18

This chapter describes how to install IC-CAP on Windows XP. 
For information on installing IC-CAP on Solaris or Linux see 
Chapter 4, “Installing IC-CAP on UNIX Systems.”
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Before You Begin
10

 

Before you begin, please take the time to go over the guidelines 
for installing IC-CAP on a PC running Windows. For last-minute 
program and documentation information, refer to the Release 
Notes document on our website at:

http://www.agilent.com/find/eesof-docs/

Choose IC-CAP 2008 > Release Notes.
Note the Changes in IC-CAP 2008

NOTE If you have systems running older versions of IC-CAP, see the following 
table for a brief description of changes in the latest IC-CAP versions and 
their impact on systems with older versions installed.
Table 1 Changes in IC-CAP 2008

Description and Reference to Details Version Introduced and Impact

Supported platforms changed.
See “Check the Windows System 
Requirements”.

IC-CAP 2008
Windows 2000 is no longer supported. 

Required CPU changed.
See “Check the Windows System 
Requirements”.

IC-CAP 2008
Intel Pentium © 4 or better, or AMD XP 
3000 or better now required.

Required RAM changed.
See “Check the Windows System 
Requirements”.

IC-CAP 2008
1 GB RAM is now the recommended 
minimum

Required hard disk space increased.
See “Check the Windows System 
Requirements”.

IC-CAP 2008
800 MB is now required for 
installation. 

Supported compilers changed. 
See “Check the Windows System 
Requirements”.

IC-CAP 2008 
Visual Studio .NET 2005 is now 
supported 
IC-CAP Installation and Customization Guide
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Support for downloading installation 
images added. 
See “Installing IC-CAP”.

IC-CAP 2008 
Installation images available for 
download. 

The version for the license server 
(lmgrd) has changed to FLEXnet 11.4.1 
from FLEXnet 10.8. 
See “Installing Licenses”.

IC-CAP 2008 
Impacts all systems, hardware keys, 
license servers, and license 
administration scripts. 

The codeword version changed to 2.7 
from 2.35. 
See “Installing Licenses”.

IC-CAP 2008 
You must obtain new FLEXnet license 
codewords from Agilent EEsof EDA. 

Table 1 Changes in IC-CAP 2008

Description and Reference to Details Version Introduced and Impact
Check the Windows System Requirements
 

Be sure your hardware and software configuration meets the 
following minimum hardware and system requirements to run 
IC-CAP, including RAM, disk space, operating systems, etc. Keep 
in mind that minimum requirements are just that, and they may 
not provide adequate performance and responsiveness.

Requirement Description

Operating System 
and Service Pack

Microsoft Windows XP Professional SP2.

CPU Intel Pentium © 4 or better, or AMD XP 3000 or better. If 
linking to 3rd party Simulators, refer to Simulator 
requirements as well.

Display High-resolution color only (Super VGA, 1024x768, 15-inch 
monitor minimum) (at least 1280x1024 required for 
Extraction packages).

RAM 1 GB RAM recommended minimum. Additional RAM up to 
2 GB will improve performance. Since IC-CAP is compiled 
on a 32-bit operating system, its processes cannot use 
more than 2 GB regardless of the maximum addressable 
memory available on your system. If linking to 3rd party 
Simulators, refer to Simulator requirements as well.
on Guide 11
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Virtual Memory 300 MB recommended minimum. Increased virtual 
memory may be required.

Web Browser IC-CAP documentation is HTML-based and displayed via a 
web browser. Microsoft Internet Explorer version 5.5 or 
higher.

Java Virtual Machine and JavaScript must be enabled on 
your browser for the documentation to appear correctly. 
You can use your browser’s internal Java support or 
download and install a Java plug-in. If you install a Java 
plug-in, the minimum recommended version is Sun Java 
Plug-in 1.3. 

Hard Disk 800 MB required for installation. It is recommended that 
you install IC-CAP software on your local drive. 
Recommended file systems are FAT32 and NTFS. Novell 
file servers are not supported. VFAT/FAT systems are not 
recommended. For more information, refer to “Ensure 
Hard Disk Storage Efficiency” on page 67.

Security Device IC-CAP software codewords are locked to an external 
device (FLEXid hardware security key) attached to the 
PC's USB or parallel port or locked to a PC's LAN ethernet 
card. Licenses can also be secured to a network server 
using FLEXlm server software.

Supported Media 
Type

CD-ROM or high speed internet access required for 
program installation.

Supported Printers Printers supported by the operating system used. (Note for 
HP LaserJet 3100 Only: There may be a conflict with the 
hardware key; if so, contact HP Printer Support by phone 
or on the web.)

Supported Plotters Plotters supported by the operating system used.

Compiler (only for 
user compiled code 
interface or open 
measurement 
interface)

C++ and C: 
Microsoft Visual Studio .NET 2005 with SP1/Hotfix

Requirement Description
IC-CAP Installation and Customization Guide



Installing IC-CAP on Windows Systems 1

IC-CAP Installation and Customizati

 

Checking the Operating System Version

To determine your operating system version, double-click the 
My Computer icon. Choose Help > About Windows.
on Guide 13
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Check the Supported Instrument Interfaces
14
If you are using IC-CAP with an NI or Agilent GPIB interface, 
install the interface and its driver according to the instructions 
supplied with the interface.

1 This is a discontinued product.
2 Typically the LAN has some impact on speed; therefore, it will most likely be 

somewhat slower than a card.
3 Agilent IO Libraries can substitute for the NI-488.2M drivers.

Description Part Number

Agilent GPIB PCI card and Agilent IO Libraries 82350A1/B

Agilent LAN/GPIB Gateway Interface and Agilent IO Libraries E5810A 2

Agilent USB/GPIB converter and Agilent IO Libraries 82357A1/B 

National Instruments PCMCIA-GPIB card and NI-488.2M 
drivers

778034

National Instruments PCI-GPIB card and NI-488.2M drivers3 778032
 

NOTE For the latest information refer to this manual on our website at: 
http://www.agilent.com/find/eesof-docs.
IC-CAP Installation and Customization Guide
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Configuring the Driver for the GPIB Interface

Your GPIB interface includes the software necessary for an 
application to use the facilities the interface provides. The 
software typically has two components: 

• A kernel driver (also known as a device driver)

• An application interface DLL, which interfaces with the 
kernel driver 

For Windows, the most recent version of the SICL drivers can be 
downloaded from the Agilent IO Libraries website located at:

http://www.agilent.com/find/iolib 
NOTE For National Instruments drivers, the most recent version can be 
downloaded from the National Instruments website located at:

http://www.ni.com
 
The downloaded file is executable. To install the Agilent IO 
Libraries, run this file and follow the supplied installation 
instructions.

After installation is complete, run the IO Config program by 
selecting Start > Programs > Agilent IO Libraries > IO Config from 
the Windows main screen.

To configure a GPIB card installed locally on the PC, select the 
relevant GPIB option (based on the Interface Description) from 
the Available Interface Types field, then click Configure > OK. 
The default settings are correct.

To configure a remote LAN/GPIB gateway, select Lan Client (Lan 
Instruments) from the Available Interface Types field, then click 
Configure > OK. The default settings are correct.
Get Codewords for IC-CAP 2008
You must have new FLEXnet license codewords to run 
IC-CAP 2008. The codewords are tied to the FLEXid of your 
hardware key or the Ethernet MAC address of your PC's 
Ethernet LAN card.
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You can request codewords via the Web at:

http://www.agilent.com/find/eesof-support

Choose Codeword Request.

The codewords are emailed to you in a license file named 
license.lic.

If you choose to tie your codewords to a hardware key (dongle), 
the hardware key was shipped with your installation media. If 
you do not have a hardware key, please contact Agilent EEsof 
Business Support at 1-800-507-6274.

See Chapter 2, “Setting up Licenses on Windows Systems” for 
more details about codewords.
Check Available Memory
Minimum recommended memory is 1 GB. More memory results 
in better overall system performance. To check the amount of 
memory on your system without rebooting, double-click the My 
Computer icon. Choose Help > About Windows.

Checking Virtual Memory

The recommended minimum virtual memory is 300 MB. IC-CAP 
model files that contain large amounts of data (such as projects 
with many devices or data values) may require more. To check 
the current amount of virtual memory: 

Select Start > Settings > Control Panel > System > Advanced > 
Performance Options. Under Virtual memory, choose Change. You 
can choose to use the current setting or change it. 
Check Available Disk Space
To check the amount of disk space on your system without 
rebooting, double-click the My Computer icon. Select View > 
Details. Look in the Free Space column for each of your drives. 
(You might have to use the bottom scroll bar to see this column.)
IC-CAP Installation and Customization Guide
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Defining an Install Folder

Be sure you have permissions to write to the disk drive on 
which you want to install IC-CAP. The installation also adds 
entries to your PC's Windows Registry. Make sure you have 
permissions to do so.
 

CAUTION The installation path for IC-CAP software cannot contain any folder 
names that use a space. For example, do not install to C:\Program 
Files\IC-CAP 2008. If you include a space in a folder name, you will get 
an error such as Could not invoke simulator when you try to run a 
simulation. You will have to uninstall IC-CAP and then install it again. 
on Guide 17
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Installing IC-CAP
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IC-CAP can be installed on a PC running Windows using either 
the IC-CAP installation CD or by downloading the IC-CAP 
installation image from the Agilent EEsof Knowledge Center 
website:

http://www.agilent.com/find/eesof-knowledgecenter

For last-minute program and documentation information, refer 
to the Release Notes document on our website at:

http://www.agilent.com/find/eesof-docs/

Choose IC-CAP 2008 > Release Notes.
IC-CAP Installation and Customization Guide
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Installation Procedure Overview

Insert installation CD 
or download image

Install program files

Install codewords

Launch IC-CAP

Run setup program

Obtain Codewords

Install FLEXid hardware 
key or use LAN card ID
Installation Steps
Use the following steps to install IC-CAP on a PC running 
Windows. If you have not done so, please review “Before You 
Begin” on page 10. Also, if you installed a pre-release Beta 
version of IC-CAP, you should uninstall it before loading this 
release.

To Install IC-CAP on Windows:
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1 Exit all Windows programs and insert IC-CAP installation CD 
into your CD-ROM drive or download the IC-CAP installation 
image from the Agilent EEsof Knowledge Center website:

http://www.agilent.com/find/eesof-knowledgecenter

2 If you downloaded the installation image, navigate to where 
you saved the file then double click the self-extracting file to 
unzip it.

3 If the Setup program does not start automatically, choose 
Start > Run and enter D:\setup, where D: is your CD-ROM 
drive or the path to the unzipped files, then click OK.

4 At the Welcome screen, choose Next to read the License 
Agreement. This is a usage agreement and is not related to 
the license codewords required to run the software. You must 
accept the agreement to continue with the installation. This 
appears only when you run Setup the first time or after 
uninstalling IC-CAP.

5 At the License Agreement screen, after reviewing the 
agreement, choose either:

• I accept the terms of the license agreement

• I do not accept the terms of the license agreement

then click Next to continue with the setup or Cancel to end the 
setup program.

6 At the Installation Directory screen, choose:

• Next to install to the default destination. 

• Browse to specify a different destination folder. If you 
specify a folder that does not exist, the installation 
program will ask if you want to create it. 
IC-CAP Installation and Customization Guide
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NOTE Using network drives (disk space that physically resides somewhere other 
than inside the PC running IC-CAP) can degrade performance in a variety 
of ways. For best performance, install IC-CAP on the local PC with the 
HOME folder also on the local PC. Do not select a network drive using File 
> Change Directory. Ensure your temporary disk space is not on a network 
drive (see Table 9, “System Environment Variables,” on page 154). 
Performance problems include, but are not limited to slow: 

• Launch time
• File load time
• UI response when opening file browsers
• PEL execution
• Simulation time
IC-CAP Installation and Customizati

 

7 At the Home Directory Settings screen, choose:

• Next to accept the default.

• Browse to specify a different folder.

The folder you specify will be the default startup folder for 
IC-CAP. It will also be used to store the configuration data in 
a subfolder called hpeesof. The path for the home directory 
cannot contain any folder names that use a space. For 
example, do not set the home directory to C:\My Home\
IC-CAP 2008. If you are using more than one IC-CAP version, 
please choose a new Home folder for each version. For the 
best performance, choose a folder on your local, not network, 
drive. 

8 At the Folder Options screen, choose either:

• Create folder and shortcuts only for current user

or

• Create folder and shortcuts for all users (default)

then type in a new folder name or click Next to accept the 
default folder name.

9 At the summary screen, review your choices then choose:

• Back to access previous screens to verify entries and make 
changes. This screen appears again if you go back to make 
other choices.
on Guide 21
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• Install to begin the installation.

• Cancel to exit the Setup without completing the 
installation.

Immediately after you click Install, the program starts 
copying files. The status screen displays the files being 
installed and shows the installation progress.

10 At the FLEXid screen, choose:

• Yes to install a FLEXid dongle (hardware key) for 
licensing.

• No to continue

11 After reading the information about how to obtain licenses or 
codewords to run IC-CAP, click Finish.

12 Install your codewords. For instructions, refer to “Installing 
Your Licenses” on page 30.

13 Install the Macrovision FLEXid software-security hardware 
key to your PC’s parallel port or use your PC LAN card’s 
ethernet ID. For instructions, refer to “Installing Your 
Licenses” on page 30.

14 To use the instrument control features in IC-CAP, install a 
GPIB interface as well as all required drivers supplied with 
the interface.
Installing from a File Server
The contents of the IC-CAP CD or downloaded and unzipped 
installation image can be copied to a file server PC enabling you 
to install IC-CAP from this file server. This arrangement is 
useful for doing silent installations (see “Silent Installations” on 
page 23). The following steps explain how to set up the file 
server and run the installation on client PCs. Agilent EEsof 
recommends that you use Windows Explorer to create folders 
and copy files in this procedure.

1 On the file server PC, create an IC-CAP2008 folder with a 
cdrom subfolder on a sharable hard disk. 
IC-CAP Installation and Customization Guide
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2 If installing from a CD, insert the IC-CAP PC installation CD 
into the file server’s CD-ROM drive. If the Setup program 
starts automatically, cancel it at your first opportunity.

3 Either copy the contents of the CD into the folder C:\
ICCAP2008\cdrom or unzip the installation image into the 
folder C:\ICCAP2008\cdrom.

To ensure coping all files, select the CD-ROM drive in 
Windows Explorer, and choose Edit > Select All, then Edit > 
Copy. Next, select the cdrom folder and choose Edit > Paste.

4 On the file server PC, share the folder C:\ICCAP2008.

In Windows Explorer, select the folder, then choose File > 
Properties. Select the Sharing tab, and complete the 
information. Click OK.

5 For each client PC on which you want to install IC-CAP, map 
the client to the folder ICCAP2008 on the file server PC. In 
Windows Explorer, choose Tools > Map Network Drive and 
complete the information.

6 On the client PCs, run setup.exe from the mapped network 
drive. You may run the normal installation described in 
“Installation Steps” on page 19, or the silent installation 
described in “Silent Installations” on page 23.
Silent Installations
The InstallShield program provided with IC-CAP supports a 
silent installation. A normal (non-silent) installation receives 
the necessary input from the person installing the software in 
the form of responses to prompts in dialog boxes. However, a 
silent installation does not display prompts for inputs. Instead, 
a silent installation gets inputs from a response file.

Silent Installation Overview

To set up and run a silent installation on a Windows PC for 
IC-CAP 2008:

1 On a server PC’s sharable hard disk, copy the contents of the 
IC-CAP installation image (from CD or downloaded and 
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unzipped) to a folder. Details about setting up a file server 
are described in “Installing from a File Server” on page 22.

2 Share this folder and map the folder to a client machine.

3 On client PCs, run the setup.exe utility using arguments for a 
silent installation, including the path and file name of the 
response file.

4 If needed, run a silent uninstallation to remove IC-CAP from 
client PCs. 

Response File Contents

The response file provides the inputs automatically during 
silent installations. The command to execute a silent 
installation includes the path and file name of the response file. 
Using our example location for the installation contents, the 
sample response.txt file is located in the ICCAP2008\cdrom\
silent folder.

The response.txt file supplies the following inputs requested by 
the installation program:

• Installs IC-CAP 2008 into the folder C:\Agilent\ICCAP_2008.

• Places shortcut icons for the Start menu in a default 
location.

• Sets the home folder to C:\users\default.

If you want to change these settings, copy the sample 
response.txt file then edit the file being careful to change only 
the settings in question to avoid corrupting the file:

• To change the installation folder, change

• -P installLocation="C:\Agilent\ICCAP_2008" and 

• -V IS_DESTINATION="C:\Agilent\ICCAP_2008" to a new 
path.

• To change the home folder setting, change

• -V MY_HOME="C:\users\default" to a new path.
IC-CAP Installation and Customization Guide
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NOTE Using network drives (disk space that physically resides somewhere other 
than inside the PC running IC-CAP) can degrade performance in a variety 
of ways. For best performance, install IC-CAP on the local PC with the 
HOME folder also on the local PC. Do not select a network drive using File 
> Change Directory. Ensure your temporary disk space is not on a network 
drive (see Table 9, “System Environment Variables,” on page 154). 
Performance problems include, but are not limited to slow: 

• Launch time
• File load time
• UI response when opening file browsers
• PEL execution
• Simulation time
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Running a Silent Installation

To run a silent installation on a client PC:

1 On the client PC, verify that IC-CAP 2008 has not already 
been installed. There should not be a C:\Agilent\ICCAP_2008 
folder since the silent installation process is not expecting it 
to be there. If IC-CAP has been installed, uninstall it.

2 On the client PC, open a Command Prompt or DOS prompt 
window. In a command prompt, change to the ICCAP2008\
cdrom folder that is shared by the server PC.

3 Execute the setup.exe command identifying the full path for 
the response file and use the silent installation option.

For example:
cd D:\ICCAP2008\cdrom
setup.exe -options "C:\temp\response.txt" -silent

4 After waiting 3 to 5 minutes for the installation process to 
finish, verify that the installation process is done by checking 
that the _uninst directory is located under the installation 
directory.
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Running a Silent Uninstallation

When you need to run a silent uninstallation on a client PC, use 
the sample response file, uninst_response.txt. Using our 
example location for the installation contents, the 
uninst_response.txt file is located in the ICCAP2008\cdrom\
silent folder.

To run a silent uninstallation:

1 In a command prompt, change to the folder containing the 
uninst_response.txt file.
cd D:\ICCAP2008\cdrom\silent

2 Copy the uninst_response.txt file to the folder C:\temp:
copy uninst_response.txt C:\temp

3 Change to the _uninst subfolder in the IC-CAP installation 
folder:
cd Agilent\ICCAP_2008\_uninst

4 Run the uninstaller:
uninstaller.exe -options "C:\temp\uninst_response.txt" 
-silent

This process opens a progress dialog box. When the dialog box 
closes, the process is done.

Troubleshooting

The most effective way to troubleshoot errors with the silent 
install/uninstall process is to run the same type of installation 
in normal or visual mode.
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Use the following information to set up licenses for IC-CAP on a 
PC running Windows. After you install IC-CAP using the steps 
described in Chapter 1, “Installing IC-CAP on Windows 
Systems,” you will need to set up the FLEXnet license manager 
and your IC-CAP license file (license.lic) before you can run 
IC-CAP.

IC-CAP uses Macrovision’s Flexible License Manager (FLEXnet) 
software for all software security configurations. When you run 
the IC-CAP Setup program, the FLEXnet software is installed at 
<installation folder>\licenses\bin where <installation folder> is 
the destination folder you specified when you ran Setup.
Using LMTOOLs for FLEXnet
IC-CAP 2008 contains the Macrovision utility lmtools with the 
FLEXnet software. This utility does not replace the steps in this 
chapter regarding license installation, but can help in the 
installation and use of FLEXnet licenses.
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The utility can be found in the \ICCAP_2008\licenses\bin folder 
and is named lmtools.exe. Using lmtools, you can:

• Determine your system’s settings, which you will need when 
you request codewords from Agilent EEsof EDA. This 
information can be found under the System Settings tab.

• Configure your FLEXnet licenses to start from a license file 
or as a Service using the Service/License File tab. If you 
choose to start FLEXnet as a service, you can configure the 
FLEXnet service from the Configure Services tab.

• Start, stop, and reread license.lic files and services using the 
Start/Stop/Reread tab.

For details on using FLEXnet and lmtools, refer to the 
documentation available at the Macrovision website:

http://www.macrovision.com/support/by_catagory/Software
_Licensing.shtml
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Launch IC-CAP

Install hardware key or 
Read Ethernet ID

Install Node-Locked License
Install Floating 

License

• Place License File
• Enter Hostname
• Set vendor daemon path
• Start FLEXnet on server
• Provide access to license file or

Set System environment variable
NOTE The Agilent License Information Tool is available to check your 
environment variable settings, display your license.lic file, and show your 
license and server status. Refer to “Using the Agilent License Information 
Tool” on page 59.
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You must request and install new license codewords for 
IC-CAP 2008. To learn how to request codewords, see “Get 
Codewords for IC-CAP 2008” on page 15. Use the steps in the 
following sections to install your IC-CAP licenses. If you have 
not done so, please review “Before You Begin” on page 10. 
Ideally, you should have installed IC-CAP before you complete 
these steps. For details on installing IC-CAP on a PC running 
Windows, please refer to “Installing IC-CAP” on page 18.

Use one of the following methods to run the FLEXnet licensing 
system on your PC:

• Install a Macrovision FLEXid hardware key.

• Read your LAN card’s ethernet ID. 
 

Installing a Hardware Key

NOTE IC-CAP 2008 installs version 11.4.1 of FLEXnet. Make sure you use the 
latest version of the FLEXnet software, drivers, and hardware key as 
needed on all IC-CAP systems and license servers.
One way to run the FLEXnet licensing system on your PC is to 
install the Macrovision FLEXid hardware key (also called a 
dongle) on a parallel port of your computer. In a node-locked 
environment, it is installed on the local computer. In a floating 
license environment, it is only required on the server.
NOTE Before you install the key, make note of the hardware key ID number that 
is printed on the key. If you have not already received your security 
codewords from Agilent EEsof, you will need to provide this number when 
you request codewords, as explained in “Get Codewords for IC-CAP 2008” 
on page 15.
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The FLEXid driver is automatically installed during the IC-CAP 
installation providing it was not already installed. If the FLEXid 
driver already exists, the installation program may not load the 
new FLEXid driver. In this case, you need to complete the 
following steps to install the latest FLEXid driver. Be aware that 
this procedure requires system administrator privileges. 
Macrovision recommends that you install the FLEXid System 
Driver with their installer, which is included in the IC-CAP 
installation image that you downloaded and unzipped or on the 
installation CD. 

To install the Macrovision FLEXid Driver:

1 Locate the installation image that you downloaded and 
unzipped or place the installation CD in your CD drive.

2 Select Start > Run (or use your Windows Explorer and skip 
the next step).

3 In the Run box, click Browse.

4 Change to the location of the installation image or CD drive.

5 If you wish to remove any existing FLEXid drivers, locate and 
double-click the FLEXidCleanupUtility.exe file. This starts 
the Macrovision FLEXid Cleanup Utility program. Click the 
Next button. When the process is complete, click Finish to 
close the utility. 

6 Locate and double-click the 
FLEXid_Dongle_Driver_Installer.exe file. This starts the 
Macrovision FLEXid Drivers installation program. For 
additional information, see the FLEXid_README.pdf file 
also located in the installation image.

7 Click the Next button.

8 Select the features you want to install, then click the Next 
button. 

9 Click the Install button. 

10 When the process is complete, a dialog box with a message to 
restart your system is displayed. 

11 Click Finish. 
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12 Restart your computer. The driver will not become active 
until your PC is rebooted. 
Using Ethernet ID
Another way to run the FLEXnet licensing system on your PC is 
to read your LAN card’s ethernet ID and have Agilent EEsof 
Business Support tie this ID to your IC-CAP codewords. To use 
this method, do the following:

1 Make sure that you have TCP/IP and IPX/SPX network 
protocols loaded on your PC. The IPX/SPX protocol is 
required by FLEXnet. To get help on network protocols, refer 
to your Windows Help for Network Protocols: 

a Choose Start > Help.

b Select the Index tab.

c Enter network protocols. 

d Click on the Display button.

e Select To install a network protocol. 

f Click on the Display button.

g Follow the help instructions, which will ask you to click in 
the help dialog box to continue.

h If you already have TCP/IP and IPX/SPX network 
protocols loaded, these items will be displayed. If you 
don’t have both, choose the Add button and select the 
needed protocols from the list that appears. For example, 
select NWLink IPX/SPX Compatible Transport to add the 
IPX/SPX network protocol.

2 Verify that you can read your LAN card’s ethernet address. 
For all versions of Windows, run the following FLEXnet 
command from the MS DOS Command Prompt:
cd \ICCAP_2008\licenses\bin
lmutil lmhostid

To obtain your LAN card’s ethernet address before you have 
IC-CAP installed, type:
ipconfig /all
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If lmutil lmhostid does not return the expected ethernet 
address of your LAN card, make sure you have the IPX/SPX 
(NWLink IPX/SPX Compatible Transport) protocol loaded.
Determining License Type

NOTE Before you can use your LAN card’s ethernet ID, you will have to let 
Agilent EEsof Business Support tie this ID to your IC-CAP codewords. If 
you have not already received your security codewords from Agilent EEsof, 
you will need to identify this number on your Codeword Request Form, as 
explained in the section, “Determining License Type” on page 33.
 

Look at the INCREMENT lines in your license.lic file to 
determine the type of licenses you have. If the INCREMENT 
lines contain the strings HOSTID= and uncounted, then your 
licenses are node-locked. Otherwise, your licenses are floating.

For example:

Node-locked License

MENT dev_bjt_gp_ee agileesofd 2.7 19-apr-2008 uncounted \
INCRE
VENDOR_STRING="00008OXXXXXX : SYAQRDS F1AQCOM CNEXTBD FBLCHLO \
WYGJYZD WTFLQZD WQYQBHI EFZ" HOSTID=00008OXXXXXX \
START=20-oct-2005 SIGN="036D 9DA2 5AA3 74FF 32AC B41E 77AA \
3C4E FBF6 BCF0 2402 613E EB0B 377A 65EB B916 109D 8F98 BA59 \
DC85 CAE9"
For Node-locked licenses, refer to “Installing Node-Locked 
Licenses” on page 35.

Floating License

MENT dev_bjt_gp_ee agileesofd 2.7 19-apr-2008 2 \
INCRE
VENDOR_STRING="0008XXOOXXOO : SYAQRDS F1AQCOM CNEXTBD FBLCHLO \
WYGJYZD WTFLQZD WQYQBHI EFZ" START=20-oct-2005 SIGN="030F 496F \
0869 F6A0 FD20 66E6 1DBF A981 22C3 4143 4B02 A946 49DC DB3B \
A791 8140 ACEB 3211 7AFE 5FFD 7143"
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For Floating licenses, refer to “Installing Floating Licenses on a 
PC Server” on page 36.
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The license.lic file containing node-locked codewords should be 
installed on the local computer. The default location for 
license.lic is <installation_folder>\licenses. For example, 
C:\ICCAP_2008\licenses\license.lic. Copy the license.lic file you 
received via email to the <installation_folder>\licenses folder.
Changing the Location of the License File

NOTE Do not execute FLEXnet’s lmgrd command for node-locked licenses. If you 
have started this program, stop it using the Task Manager or re-boot your 
PC.
 

If you use the default license file location, your environment 
variables are set automatically. To use the license.lic file from a 
different location, set the AGILEESOFD_LICENSE_FILE 
environment variable to point to the location.

To define the environment variable:

• Choose Start > Settings > Control Panel > System > Advanced > 
Environment Variables then add a new variable named 
AGILEESOFD_LICENSE_FILE that points to the full path to 
the license.lic file.

Your environment variable can be entered either as a user 
variable or as a system variable. The user variable affects only 
the currently logged-in user; the system variable affects all 
users. For a node-locked license, be sure you add the 
AGILEESOFD_LICENSE_FILE variable to the System 
Environment, not the User variables.
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Use the following sections to install your IC-CAP floating 
licenses. You should have installed IC-CAP before you complete 
these steps. For details on installing IC-CAP on a PC running 
Windows, please refer to “Installing IC-CAP” on page 18.
 

Installing the License File

NOTE Be sure to use the following information to update all existing license 
servers with the latest version of the FLEXnet software (e.g., lmgrd and 
lmutil). The software is installed with IC-CAP 2008. Using older versions 
may cause license-encryption errors, invalid hostid results, and 
unsupported feature errors.

Verify that all multiple and redundant servers are updated including any 
license administration scripts in use. Run lmutil directly from the 
IC-CAP 2008 installation location (<installation folder>\licenses\bin) for 
information to help modify the scripts.

You will need to stop, then restart, the license server to make these 
updates.
The license.lic file that implements FLEXnet security must be 
installed to run IC-CAP. The default install path is <installation 
folder>\licenses; for example: C:\ICCAP_2008\licenses\
license.lic. Copy the license.lic file that you received via e-mail 
to the <installation folder>\licenses folder. 

If your licenses will be served by a central server, have your 
system administrator install the license.lic file on the license 
server.
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Change the default hostname setting in your license file to the 
actual hostname of your license server. The license server is the 
computer that will serve the licenses on the network, and whose 
Ethernet address or FLEXID hardware key number, appears on 
the SERVER line.

For example, lets assume that a computer with FLEXID 
hardware key number 8-5E700059B957 has a hostname of 
joshua. The SERVER line should read:

   SERVER joshua FLEXID=8-5E700059B957

License files are generated with SERVER lines with the 
following format:

   SERVER <hostname> <hostid>

where

<hostname> is set to unknown by default

<hostid> is the FLEXID hardware key number or Ethernet 
address of the license server.

You can also specify a specific TCP port number for license 
requests as follows:

SERVER <hostname> <hostid> <tcp_port>

Any computer that runs IC-CAP and wants to checkout licenses 
from this license server will need to set 
AGILEESOFD_LICENSE_FILE as follows:

AGILEESOFD_LICENSE_FILE=2100@joshua

If you do not specify a TCP port number on the SERVER line in 
your license.lic file, the license server will automatically use the 
first available TCP port in the range 27000 to 27009. In this 
case, you should set AGILEESOFD_LICENSE_FILE as follows:

AGILEESOFD_LICENSE_FILE=@joshua
NOTE Enter a specific port address on the SERVER line for improved license 
check-out performance. You may enter a port address outside the range of 
27000 to 27009, as long as the address is not used elsewhere. Then set the 
environment variable AGILEESOFD_LICENSE_FILE.
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By default, no path is specified to the agileesofd vendor daemon 
executable. This is acceptable as long as lmgrd and agileesofd 
are in the same folder when you start FLEXnet. 

In the typical license configuration, lmgrd and agileesofd are 
both located in the \ICCAP_2008\licenses\bin folder. When 
lmgrd is started from the \ICCAP_2008\licenses\bin folder, it 
looks for agileesofd in the same folder. If agileesofd is not in the 
same folder as lmgrd, you must specify a path to it using the 
following syntax:
VENDOR agileesofd C:\ICCAP_2008\licenses\vendors\agileesofd
Starting FLEXnet
FLEXnet can be started either manually or automatically. You 
must start the FLEXnet license manager daemon (lmgrd) on the 
license server(s) first. Once the license server(s) is running 
lmgrd and has started the vendor daemon(s), you can configure 
the other computers (clients) and user login accounts that need 
to access IC-CAP.

To start FLEXnet you need the following.

• FLEXnet software installed in the <installation_location>\
licenses folder. This is done when you install IC-CAP.

• The license server computer connected to the network using 
the TCP/IP network protocol.

• A local copy of the license.lic file that contains the FLEXnet 
codewords. Every computer that will run IC-CAP must be 
able to access the license.lic file used by the license server(s) 
to check out a license. Access to the license.lic file can be via 
a local copy of the license.lic file or through a network drive.

• Properly configured SERVER and VENDOR lines in your 
license.lic file.

If you have a three-server redundant configuration, you must 
start FLEXnet on all three servers before the licenses will be 
available on the network. Once you have FLEXnet running, you 
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can configure the other computers (clients) and user login 
accounts that need to access IC-CAP by setting 
AGILEESOFD_LICENSE_FILE.

Starting FLEXnet Manually

While starting FLEXnet manually is a good way to verify that 
FLEXnet starts correctly, it is generally not recommend for a 
server, because it requires a dedicated MS-DOS Command 
Prompt to be open at all times and it requires re-starting after 
rebooting the license server. Use the following steps to start the 
FLEXnet executable file, lmgrd.exe:

1 From a MS-DOS Command Prompt, change to 
<installation_directory>\licenses\bin, where 
<installation_directory> is the folder where you installed 
IC-CAP.

2 Type the following command specifying the full path and 
location of the license file.
lmgrd -app -c <installation_directory>\licenses\
license.lic  -l  <inst_dir>\licenses\flex.log

To shut down the license manager, enter the following at a 
command prompt, from the < installation_directory>\licenses\
bin folder:
lmutil lmdown -c <installation_directory>\licenses\license.lic

Starting FLEXnet Automatically

Ideally you should configure FLEXnet to start up automatically 
each time your system is booted by installing the license 
manager as a Control Panel service.

To start the license manager automatically:

1 From a MS-DOS Command Prompt, change to 
<installation_directory>\licenses\bin, where 
<installation_directory> is the folder where you installed 
IC-CAP.

2 Enter the full path and filename of both the license 
executable file and the license.lic file. The default location 
for the executable file is <installation_directory>\licenses\
bin\lmgrd.exe. (The flex.log file is useful for 
troubleshooting.)
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install -e <path to lmgrd> -c < path to license file> -l
<path to flex.log>

For example:
install -e d:\ICCAP_2008\licenses\bin\lmgrd.exe -c 
d:\ICCAP_2008\licenses\license.lic -l 
d:\ICCAP_2008\licenses\flex.log

If you did not specify a flex.log file using the “-l” option when 
you ran install.exe in step 2, FLEXnet creates a default log 
file in the system 32 folder. While this default log file does not 
contain as much information, it can still be useful. This file is 
typically located in c:\winnt\system32\ and is named 
lmgrd.log or lmgrd.xxxx where xxxx is the process ID 
number of lmgrd.

3 Activate the license server by starting the FLEXnet service 
using the Control Panel or by rebooting the system:

Start > Settings > Control Panel > Administrative Tools > Services

Double-click on the FLEXnet License Manager service and click 
on the Start button.

To remove the license manager from the service list and cancel 
the automatic FLEXnet startup:

From your system prompt, change to the license folder and 
enter: install -r

To change the path to your license file, first remove the existing 
FLEXnet service using the installs -r command, reinstall 
FLEXnet using the new location, and then reboot your system.
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You need to configure each PC client to access the license server 
and to check out a license. You can do this by using one of two 
methods:

• Place a copy of the license.lic file in the 
<installation_directory>\licenses folder of each local 
computer.

• Configure the AGILEESOFD_LICENSE_FILE to point to the 
license file.

Typically, it is best to use the port@host syntax to set the 
AGILEESOFD_LICENSE_FILE to point to the license server.

set AGILEESOFD_LICENSE_FILE=27000@joshua

Where 27000 is the TCP port number on the SERVER line in the 
license.lic file and joshua is the hostname of the license server.

If your license server is set up to search for an available port, 
use the @host syntax to set the AGILEESOFD_LICENSE_FILE 
to point to the license server.

set AGILEESOFD_LICENSE_FILE=@joshua

You can also set AGILEESOFD_LICENSE_FILE to the full path 
and filename of the license.lic file used by the license server:
set AGILEESOFD_LICENSE_FILE=C:\ICCAP_2008\licenses\license.lic
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You can access licenses from a UNIX license server by doing the 
following:

1 Set up the UNIX license server(s) to use FLEXnet version 
11.4.1 or higher lmgrd and agileesofd daemons.

2 Set up the PC to access the UNIX license server’s license.lic 
file.
Setting Up the UNIX License Server
You must use version 11.4.1 or higher of the FLEXnet daemons 
lmgrd and agileesofd. Use the following commands to check the 
version of lmgrd and agileesofd on your UNIX license server:

cd $ICCAP_ROOT/licenses/bin
. / lmgrd -version
cd $ICCAP_ROOT/licenses/vendors
. / agileesofd -v

Use the following steps to update current FLEXnet daemons on 
your license server:

1 Stop the current FLEXnet daemons on the license server:
cd $ICCAP_ROOT/licenses/bin
. /lmutil lmdown -c ../license.lic

2 Replace the following files with the supported FLEXnet 
version files:
$ICCAP_ROOT/licenses/bin/lmgrd
$ICCAP_ROOT/licenses/bin/lmutil
$ICCAP_ROOT/licenses/bin/agileesofd

If you have more than one license server, make sure you do 
this on all of them.

3 Restart the license daemons on the UNIX license server(s):
cd $ICCAP_ROOT/licenses/bin
. / lmgrd -c ../license.lic -l ../flex.log
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Your PC can access the UNIX license server’s license.lic file in 
either of two ways:

• By copying the license.lic file from the UNIX license server to 
the PC’s <installation_directory>\licenses folder

• By setting the AGILEESOFD_LICENSE_FILE variable on the 
PC to point to the UNIX license server as follows:
set AGILEESOFD_LICENSE_FILE=<port>@<host>

For example:
set AGILEESOFD_LICENSE_FILE=27000@joshua

where 27000 is the port number on the SERVER line in the in 
the license.lic file and joshua is the hostname of the UNIX 
license server.

To set an AGILEESOFD_LICENSE_FILE system environment 
variable that points to the license.lic file, use the steps outlined 
in “Changing the Location of the License File” on page 35.
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Be sure to use the lmtools utility to install an IC-CAP license on 
a server that is already running FLEXnet. For details on using 
FLEXnet, refer to the Macrovision website at:

http://www.macrovision.com/support/by_catagory/Software
_Licensing.shtml
Using FLEXnet Options
An options file enables the license administrator to control the 
security parameters of FLEXnet. Specifically the license 
administrator can:

• Allow the use of features based on user, hostname or display 
name.

• Deny the user of features based on user, hostname or display 
name.

• Reserve licenses based on user, hostname or display name.

• Control the amount of information logged about license 
usage.

Creating an Options File

Use the desired options listed to create the options file using 
any text editor. Ideally, you should keep the options file in the 
same directory as your license.lic file. Also, add the pathname 
to the options file in the license.lic file as the fourth field on the 
VENDOR line for agileesofd as shown in the following example. 
(Remember to use the backslash (\) character if the file 
contains wrapped lines.)
VENDOR agileesofd C:\ICCAP_2008\licenses\vendors\agileesofd \
C:\ICCAP_2008\licenses\agileesofd.opt

You can include comments in your options file by starting each 
comment with a pound sign '#'. Everything in the options file is 
case-sensitive. Be sure that user names and feature names, for 
example, are entered correctly. The available options are:

• EXCLUDE
Deny a user access to a feature.
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• EXCLUDEALL
Deny a user access to all feature served by this vendor 
daemon.

• GROUP
Define a group of users for use with any options.

• INCLUDE
Allow a user to use a feature.

• INCLUDEALL
Allow a user to use all features served by this vendor 
daemon.

• NOLOG
Turn off logging certain items.

• REPORTLOG
Specify that a logfile be written suitable for use by the 
FLEXadmin End-User Administration Tool.

• RESERVE
Reserve licenses for an individual user or groups of users.

Use the following steps to create and use an options file. Details 
about each step located in previous sections:

1 Create an options file with your required options.

2 Modify your license.lic file so that the VENDOR or DAEMON 
line points to this option file as shown in this example:
VENDOR agileesofd C:\ICCAP_2008\licenses\vendors\agileesofd \
C:\ICCAP_2008\licenses\agileesofd.opt

3 Start up your license server (lmgrd) that is pointing to your 
license file. You must stop it first if it is running. It’s 
important that a message is displayed or recorded in the 
FLEXnet log verifying the license manager is using the 
options file. 

4 Set AGILEESOFD_LICENSE_FILE to point to your license 
server.

5 Run IC-CAP.
on Guide 45



2 Setting up Licenses on Windows Systems
Updating the License File
46

 

If you have been running FLEXnet and receive updated 
codewords from Agilent EEsof, you can add the new licenses to 
the FLEXnet environment as follows:

1 Replace the existing license.lic files on the license servers 
and clients with the new license.lic file.

2 On the primary server, run lmutil lmreread. This causes 
the lmgrd on the primary server to re-read the license.lic file 
and update all of the other lmgrd processes on the network.

3 After you have done this, you can run lmutil lmstat -a 
to verify that the license servers have received the new 
license information. 

If this does not work, you may need to stop all of the lmgrd 
processes on your network and then restart them as described 
in “Starting FLEXnet” on page 38.
Merging Multiple Vendor Licenses
When you are running FLEXnet-licensed products from 
multiple vendors, you may need to take steps to prevent 
licensing conflicts during installation:

• Multiple license server nodes; each running one lmgrd and 
one license file 

• One license server node running one lmgrd and one license 
file 

• One license server node running multiple lmgrds and 
multiple license files 

Each lmgrd can only read a single license file. In the first option 
you will have more license servers to monitor. With the third 
option you have only one server but multiple lmgrds to 
administer. 

Your product's license file(s) define the license server(s) by 
hostname and hostid in the SERVER line(s) in the license file. 

• If the license files for two or more products contain identical 
hostids on the SERVER line(s), then these files can be 
combined. 
IC-CAP Installation and Customization Guide



Setting up Licenses on Windows Systems 2

IC-CAP Installation and Customizati

 

• If the license files for two products contain different hostids 
on a SERVER line, then the license servers for those products 
will be running on different nodes and the license files 
cannot be combined.

If you have two or more products whose license servers run on 
the same node (as specified by the SERVER lines in the license 
files), you may be able to combine the license files into a single 
license file. 

• If the SERVER lines in those files have identical hostids, then 
you can combine the files into a single file. 

• If the SERVER lines have different hostids, then you must 
keep the license files separate. 

Essentially, you can combine two license files under the 
following conditions:

1 The number of SERVER lines in each file is the same.

2 The hostid field of each SERVER line in one file exactly 
matches the hostid field of each SERVER line in the other 
file. 

Some possible reasons license files may not be compatible are: 

• License files are set up to run on different server nodes, so 
hostids are different. 

• One file is set up for single server (has only one SERVER 
line), the other is set up for redundant servers (has multiple 
SERVER lines).

• One vendor uses a custom hostid algorithm, so the hostids on 
the SERVER lines are different even though the files are for 
the same computer. 

If your license files are compatible as described above, then you 
can combine license files and run a single lmgrd, as described in 
“Combining License Files from Multiple Vendors” on page 48. If 
the license files are not compatible, then you must keep the 
license files separate and run separate copies of lmgrd for each 
license file, as described in “Using Separate License Files on the 
Same Server Node” on page 49.
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NOTE There is virtually no performance or system-load penalty for running 
separate lmgrd processes.
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Combining License Files from Multiple Vendors

If your license files are compatible, you can combine them with 
any text editor. To combine license files, read all of the 
compatible license files into one file, then edit out the extra 
SERVER lines so that only one set of SERVER lines remains. 
Write out this data, and you have your combined license file. 

If you combine license files from multiple vendors, it is a good 
idea to keep a copy of the combined license file in each vendor's 
default license file location. This way, your users can avoid 
having to set AGILEESOFD_LICENSE_FILE, because each 
package finds its license information in the default place. On 
UNIX, you can do this with a symbolic link from each default 
location to the location of the combined license file.

FLEXnet Version Component Compatibility

When you combine license files for two different 
FLEXnet-licensed products, the products may not use the same 
version of FLEXnet. FLEXnet is designed to handle this 
situation. There are two basic compatibility rules for FLEXnet:

1 A newer lmgrd can be used with an older vendor daemon, 
but a newer vendor daemon might not work properly with an 
older lmgrd. 

2 A newer vendor daemon (or lmgrd) can be used with an 
older client program, but a newer client program might not 
work properly with an older vendor daemon. 

From these two compatibility rules come the simple rules for 
selecting which version of administration tools to use: 

1 Always use the newest version of lmgrd and the newest 
version of each vendor daemon. 

2 Use the newest FLEXnet utilities. 
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For specific application programs, you can use either the new or 
the old version (with the assumption that the vendor daemon 
for that application is at least as new as the application).

Using Separate License Files on the Same Server Node

You must run a separate copy of lmgrd for each license file. 
When you run multiple copies of lmgrd, there are two details to 
remember:

1 The port number on the SERVER line of each license file 
must be unique. You can use a standard text editor to change 
the port number in each license file so that they are all 
different. 

2 You must make sure that you are using a compatible version 
of lmgrd when you start it up for a particular license file. 
This can be done by using an explicit path to lmgrd. 

When running client programs (such as a licensed application), 
you can set the AGILEESOFD_LICENSE_FILE environment 
variable to point to multiple license files. For example, you may 
have a license file from vendor ABC and a license file from 
vendor XYZ with incompatible servers. You can place the license 
file from vendor ABC into:

C:\user\flexnet\abc.lic

and the license file from vendor XYZ into:
C:\user\flexnet\xyz.lic

then set the AGILEESOFD_LICENSE_FILE environment 
variable to point to both of them. The syntax is as follows:

AGILEESOFD_LICENSE_FILE=27000@server1;27000@server2;
27000@server3

Note that each path is separated with a semi-colon.

AGILEESOFD_LICENSE_FILE can point to only one license file 
for FLEXnet v1.x applications.
Setting Up Redundant License Servers
FLEXnet allows you to setup a redundant license server 
configuration. This involves configuring three license servers. 
One of the three servers is the master server. If the master 
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server goes down, one of the remaining two servers becomes the 
new master server, and licenses remain available on the 
network.

Setting up a redundant server scheme requires extra system 
administration and is not recommended unless you have an 
absolute need for it.

To set up redundant license servers, use the same FLEXnet 
procedures on all three servers. All three servers need to be up 
and running before you licenses will be made available.
Controlling License Path Settings
The lmutil utility provides the lmpath function, which allows 
direct control over FLEXnet license path settings. You can use 
lmpath to add to, override, or get the current license path set in 
the registry. This enables you to change or view path settings 
without locating individual settings in the Windows registry on 
the PC or in the FLEXnet registry (.flexlmrc) on UNIX.

The lmutil utility is located in $ICCAP_ROOT\licenses\bin. This 
location must be in your PATH, or use the following command 
before running the utility:

cd $ICCAP_ROOT\licenses\bin
lmutil lmpath {-status | -add | -override} {vendor_name |
all} license_path_list

where

-status displays the current license path settings.

-add appends license_path_list to the front of the current 
license-path settings or creates the list of license-path 
settings, if it doesn’t exist, initializing it to license_path_list. 
Duplicates are discarded.

-override overrides the existing list of license-path settings 
with the contents of license_path_list. If license_path_list is 
the null string, "", the specified list is deleted. For example:

• lmutil lmpath -override agileesofd ""
Deletes the value of AGILEESOFD_LICENSE_FILE from 
the registry.
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• lmutil lmpath -override vendor2 ""
Deletes the value of VENDOR2_LICENSE_FILE from the 
registry.

• lmutil lmpath -override all ""
Deletes the value of LM_LICENSE_FILE from the registry.

vendor is a string naming a particular vendor daemon name. 
Affects the value of vendor_LICENSE_FILE. For example, 
use agileesofd to affect AGILEESOFD_LICENSE_FILE.

all refers to all vendor daemons. Affects the value of only 
LM_LICENSE_FILE. 

license_path_list is the new path setting(s). On UNIX, this is 
a colon-separated list, and on Windows it is a 
semi-colon-separated list. If license_path_list is the null 
string, "", then the list is deleted for the specified vendor. 
Though you can enter specific license file names, you gain 
flexibility by entering only a path without a file name. This 
will include all *.lic files in the same location.
 

NOTE Environment variable settings (set in your shell) always override these 
registry settings.
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Checking the Status

Before you change license path settings, Agilent recommends 
that you display the current settings. To display the settings, 
enter the following commands:

lmutil lmpath -status

The following shows an example status listing: 
lmutil - Copyright (C) 1989-2004 Macrovision Corporation. 
All rights reserved.
Known Vendors:
_____________
agileesofd: C:\Agilent\ICCAP_2008\licenses\license.lic
_____________
Other Vendors:
______________

C:\flexlm\license.dat
NOTE Where a path is set to a directory, each of the *.lic files are listed 
separately.
Changing License Path Settings

When adding or overriding path settings, lmpath sets the 
FLEXnet entry in the Windows registry on the PC, or changes 
the file $HOME/.flexlmrc on UNIX. Here are examples of how 
license settings may appear in each registry:

UNIX:
AGILEESOFD_LICENSE_FILE = /iccap2008/licenses

Windows:

Registry location:
My Computer\HKEY_LOCAL_MACHINE\Software\Agilent\ICCAP_2008

Registry license path setting:
AGILEESOFD_LICENSE_FILE REG_SZ C:\Agilent\ICCAP_2008\licenses
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To change license path settings, enter the appropriate command 
in a Command Prompt on Windows, or a terminal window on 
UNIX. You can adapt the following examples which change path 
settings for AGILEESOFD_LICENSE_FILE:

• To add path settings on UNIX:
lmutil lmpath -add agileesofd <new_lic_path1>:<new_lic_path2>

• To add path settings on Windows:
lmutil lmpath -add agileesofd C:\<new_lic_path1>;C:\
<new_lic_path2>

• To replace the current path settings on UNIX:
lmutil lmpath -override agileesofd <new_lic_path>

• To replace the current path settings on Windows:
lmutil lmpath -override agileesofd C:\<new_lic_path>
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This section discusses how to manage the licenses for multiple 
versions of IC-CAP.
Backward Compatibility of Codewords
The following table lists previous IC-CAP versions with details 
of their license management. The compatibility of codewords 
with the various IC-CAP versions is discussed below.

  
 

Release Name License 
File 
Version

Daemon 
Name

FLEX Version License Environment 
Variable

Default License File 
Location

IC-CAP 2002 6.1 agileesof FLEXlm 7.2h AGILEESOF_LICENSE_FILE $ICCAP_ROOT\licenses

IC-CAP 2004 2.3 agileesofd FLEXlm 8.2a CRO AGILEESOFD_LICENSE_FILE

IC-CAP 2006 2.35 agileesofd FLEXnet10.1.3 CRO AGILEESOFD_LICENSE_FILE

IC-CAP 2008 2.7 agileesofd FLEXnet 11.4.1 AGILEESOFD_LICENSE_FILE
The following table shows the codeword compatibility between 
various IC-CAP releases. Note that codeword compatibility also 
depends on the whether the codeword was available in that 
release.
Codewords From 
This Release

Will Work With This Release

IC-CAP 2008 IC-CAP 2006 IC-CAP 2004 IC-CAP 2002

IC-CAP 2008 X X

IC-CAP 2006 X X

IC-CAP 2004 X

IC-CAP 2002 X
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For IC-CAP 2008, the vendor daemon agileesofd is used. If you 
want to serve IC-CAP 2008 licenses and earlier from the same 
server, you need to have the latest version of lmgrd, v11.4.1, and 
one or more DAEMON lines in your license file, depending on 
how many versions you want to support. The IC-CAP daemon 
names available are:

agileesofd - for IC-CAP 2004/2006/2008

agileesof - for IC-CAP 2002

For example, the license file would include:
SERVER hpnmems 77a588a7 1700

VENDOR agileesofd C:\ICCAP_2008\licenses\vendors\agileesofd
VENDOR agileesof C:\ICCAP_2002\licenses\vendors\agileesof

The INCREMENT lines for the different products would then be 
added to the file.
 

NOTE If combining codewords for IC-CAP 2002 and ADS 2002 or 
ADS 2002C, use the agileesof daemon included with ADS since 
it is a newer version than the one included with IC-CAP.
Here is how you might build a license file that contains 
IC-CAP 2008, ADS 2003C, and ADS 2002C codewords. The name 
and extension of the license file are arbitrary (i.e., license.lic or 
iccaplicenses.txt). By default, IC-CAP 2002, IC-CAP 2004, and 
IC-CAP 2008 look for a file named license.lic. You can use 
license.lic, or some other name you prefer. Whatever name you 
choose to use, make sure you set the environment variables to 
point to your license file.
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Supported environment variables are: 

• AGILEESOFD_LICENSE_FILE for IC-CAP 2004/2006/2008

• AGILEESOF_LICENSE_FILE for IC-CAP 2002

For example, if the combined codeword file is named 
iccaplicenses.txt, then:

• IC-CAP 2008 will use:
AGILEESOFD_LICENSE_FILE=C:\ICCAP_2008\licenses\iccaplicenses.txt

• IC-CAP 2002 will use:
AGILEESOF_LICENSE_FILE=C:\ICCAP_2002\licenses\iccaplicenses.txt

Each version of IC-CAP uses a certain search order to look for 
the environment variable:

• IC-CAP 2004/2006/2008 will first look for the environment 
variable named AGILEESOFD_LICENSE_FILE. If both 
AGILEESOFD_LICENSE_FILE and LM_LICENSE_FILE are 
defined, IC-CAP 2004/2006/2008 will use 
AGILEESOFD_LICENSE_FILE and ignore 
LM_LICENSE_FILE. If AGILEESOFD_LICENSE_FILE is not 
defined, then IC-CAP 2004/2006/2008 will default to 
LM_LICENSE_FILE.

• IC-CAP 2002 will first look for the environment variable 
named AGILEESOF_LICENSE_FILE. If both 
AGILEESOF_LICENSE_FILE and LM_LICENSE_FILE are 
defined, IC-CAP 2002 will use AGILEESOF_LICENSE_FILE 
and ignore LM_LICENSE_FILE. If 
AGILEESOF_LICENSE_FILE is not defined, then IC-CAP 
2002 will default to LM_LICENSE_FILE.
NOTE Even though all versions of IC-CAP will default to LM_LICENSE_FILE if 
that is the only environment variable that exists, it is recommended that 
you use AGILEESOFD_LICENSE_FILE for IC-CAP 2004/2006/2008 and 
AGILEESOF_LICENSE_FILE for IC-CAP 2002.
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ne 80FB214D 1700
 

SERVER solaro
VENDOR agileesofd C:\ICCAP_2008\licenses\vendors\agileesofd
VENDOR agileesof C:\ICCAP_2002\licenses\vendors\agileesof
#
# ADS 2002C Codewords
#
INCREMENT ads_datadisplay agileesof 2.0 30-jun-2002 1 \

VENDOR_STRING=80FB214D HOSTID=80fb214d SIGN="008E 5A70 FECF \
8BEF 9B3A 8A67 7375 0A51 0940 A264 6B00 C335 666B 03E2 D8E7 \
99A8 A0F9 9007 2AC4 EF7D E101"

INCREMENT ads_datadisplay agileesof 2.0 30-jun-2002 1 \
VENDOR_STRING=80FB214D SIGN="01CB 4272 B241 5A67 A4C8 CADB \
A080 FFB2 7796 6C29 EC02 C3A9 FD8A BE47 C0C0 F027 5552 947F \
64CC 06BA 2201"

INCREMENT ads_drc agileesof 2.0 30-jun-2002 1 VENDOR_STRING=80FB214D \
HOSTID=80fb214d SIGN="0138 3E48 7191 3703 8FFB 2614 067B 2A7E \
203F 4F0C C900 79FE F186 9B1E 2B10 3B3D D650 2204 18CF 00C9 \
3E3A"

INCREMENT trans_veriloggen agileesof 2.0 30-jun-2002 1 \
VENDOR_STRING=80FB214D HOSTID=80fb214d SIGN="014D A119 4C16 \
9831 16B3 B5C6 EFE7 ED11 D0AE F389 EA00 590B 0E0A E0CD 5E4D \
9CE6 E6AD B27E 2CC4 8C1A 1D9D"

INCREMENT trans_veriloggen agileesof 2.0 30-jun-2002 1 \
VENDOR_STRING=80FB214D SIGN="0332 DEBA 8398 B80F D2A0 0237 \
BF97 0C7E 1CF3 CB15 2902 A5CB 47FA ECCB 9C6B BED2 E3D9 FBEB \
EF84 FAFE 7AC8"

INCREMENT trans_vhdlgen agileesof 2.0 30-jun-2002 1 \
VENDOR_STRING=80FB214D HOSTID=80fb214d SIGN="03D0 0C40 7E3C \
E656 F8A8 ADF2 B161 97C1 CE6C DC0C DA00 A704 91C9 F5A0 30C6 \
DA2A 60C0 A435 E003 02A0 C7A4"

INCREMENT trans_vhdlgen agileesof 2.0 30-jun-2002 1 \
VENDOR_STRING=80FB214D SIGN="028D FD25 D0E4 AD1A A0B7 5D61 \
E2A8 7CC2 8135 D605 8200 F200 39D8 E5AF 4B9E D240 3682 4BAA \
D9BD 6FB3 E580"

#
#ADS2003C codewords
#
INCREMENT ads_datadisplay agileesofd 2.3 07-jul-2003 1 \

VENDOR_STRING="00047518D858 : O2GAZUD WSGSONJ 2HNECZL 12WKCKE \
LRXYGSO MWYFKGP AKBPONX LOYSO" HOSTID=00047518d858 SIGN="0246 \
771A BBA2 A0D4 B29E 7371 6FF7 F3D9 161A 1204 EE00 2E92 8AC0 \
1AF7 FAF9 5B2C B017 23F7 91E8 BF97 B9AD"

INCREMENT ads_drc agileesofd 2.3 07-jul-2003 1 \
VENDOR_STRING="00047518D858 : QEGHABO KEYWTHV 1HEIWND JFAVQ2A \
UJXJ2EW KYARWEQ GY" HOSTID=00047518d858 SIGN="02EC 9EA3 EE62 \
BDBC 9793 019D 0551 FD3E 20DD D0C1 D301 DA95 9F79 16A8 5E11 \
1B81 E7CC 90F8 68A0 E116 8F0B"

INCREMENT ads_encoder agileesofd 2.3 07-jul-2003 1 \
VENDOR_STRING="00047518D858 : GONJAZX FHGGNAP BWOGIAH PBKWEYK \
UCKGULO YSO2GAZ UDWSGS" HOSTID=00047518d858 SIGN="027B 178E \
2893 8446 A5C4 0990 830E CC2C F215 528B 6401 9B93 9540 A54C \
B85A A68E 0049 200F 1685 96D1 FD7F"

INCREMENT ads_layout agileesofd 2.3 07-jul-2003 1 \
VENDOR_STRING="00047518D858 : BUYPSCY ESZGY2G PVZBPON XODFINY \
IUIUACJ EFQGAUY XLYSX" HOSTID=00047518d858 SIGN="032E E2FE \
1D41 5386 F290 C7AA 207B 20C6 9187 D2D5 0D00 7DB9 8FF8 531A \
9947 9A9D 5D72 A8E6 9807 3037 F7EA"
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#
#IC-CAP 2008 codewords
#
INCREMENT dev_bjt_gp_ee agileesofd 2.7 19-mar-2008 2 \

VENDOR_STRING="00008XXOOXXO : SYAQRDS F1AQCOM CNEXTBD FBLCHLO \
WYGJYZD WTFLQZD WQYQBHI EFZ" START=20-oct-2005 SIGN="023E 6EC8 \
0EAD 7537 5072 CA30 C5F9 3DAE 73BC 3168 D601 453A F3BE F758 \
ACE2 4576 CE88 FB0E 8663 C8EE 918B"

INCREMENT dev_bsim3 agileesofd 2.7 19-mar-2008 2 \
VENDOR_STRING="00008XXOOXXO : WVRFWQG PJEL1QG AUYILYS XUYGJCY \
L2WEYGO LSRXYBG PHEUL" START=20-oct-2005 FFA0 0BD3 8206 B191 \
E658 F333 440F 8D03 17F3 D6CB A53B C176 1CDF 5A91 6BB4 28D0 \
1386 E211"

INCREMENT dev_bsim4 agileesofd 2.7 19-mar-2008 2 \
VENDOR_STRING="00008XXOOXXO : WZJDCYM NBWJ1YM YMQGRFW XSUCLYD \
GXDWYGJ YZDWTY2 NMAJ" START=20-oct-2005 SIGN="012B FF53 9F9D \
3ED9 47A5 8744 E57E 4B07 9FC0 B0F1 7D03 A125 35B2 3FF2 9C97 \
ABE9 66E5 D12D 5EDD 718D EC6A"

INCREMENT dev_bsimsoi agileesofd 2.7 19-mar-2008 2 \
VENDOR_STRING="00008XXOOXXO : KKEYWEH VXGIJRV WDYLNT2 ACFUBHA \
VU2JOEN WFMJOPB SOKTNCH 1O" START=20-oct-2005 SIGN="001A C20B \
3EDE 88BE 0FAF D892 4310 DCE0 9D76 0830 B100 71FA E487 CD4F \
EEDE E019 2E71 F2D5 D338 A728 D607"
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The Agilent License Information Tool is available to check your 
environment variable settings, display your license.lic file, and 
show your license and server status. 

You can access this tool in two ways:

• From the IC-CAP Main or Schematic window, choose Help > 
License Information. 

• If you are unable to run IC-CAP, you may be having a problem 
with licenses. In this case, from an MS-DOS command 
prompt, type <installation folder>\bin\aglmtool 
then press Enter.
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Environment    Lists environment/license variables and computer 
information that affect your IC-CAP license configuration. This 
information can be very helpful when debugging license trouble. 
Use the Compact View option to wrap the lines making it easier 
to see where multiple path statements start and stop. 

Licenses    Lists all licenses found in the license.lic file installed 
on your computer, or in the case of a network installation, the 
license server. Use the Compact View option to wrap the lines 
making it easier to view complete license statements. Click 
Refresh if the license.lic file has been modified while viewing 
license information. 

Servers    Lists all license servers serving Agilent EEsof licenses 
on your network. You can expand any given server to see the 
licenses served by that server. 

Usage    This pane enables you to view the current status of all 
installed licenses. You can sort by Licenses (multiple licenses 
for a single feature) or by Users (select the User Info option 
first). Select All to view a complete list of installed licenses. 
Select Available to view only those licenses that are currently 
available. Select In Use to view only those licenses that are 
currently in use. 
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Using IC-CAP on Windows Systems

Running IC-CAP 62

How Do I... 65

To get you started using IC-CAP on a PC running Windows, this 
section includes some basics along with useful tips for resolving 
problems that might occur after you have installed IC-CAP.
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Running IC-CAP
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Your FLEXnet license file must be properly configured and 
installed before you can run IC-CAP. To set up your license file, 
follow the instructions in Chapter 2, “Setting up Licenses on 
Windows Systems.” 

To run IC-CAP from the Start menu, select Programs > 
IC-CAP 2008 > <name of application>.

where <name of application> is one of the following:

• IC-CAP. Launches the IC-CAP Main window.

• IC-CAP Documentation. Brings up your Web browser and the 
starting point for accessing IC-CAP documentation. The 
documentation files are accessed from:

• UnInstall IC-CAP 2008. Launches the Uninstall Program. For 
information on using this utility, refer to “Delete All Installed 
Files” on page 65.
 IC-CAP Does Not Start
It is possible to install programs or options for which you have 
not purchased licenses. Although the icons and features will 
appear in the software, you cannot access the applications 
without a license. Contact your Agilent EEsof sales 
representative to obtain additional licenses.

If your IC-CAP applications will not start:

• Make sure all of your licensing requirements are correctly set 
up, as explained in Chapter 2, “Setting up Licenses on 
Windows Systems.”

• Using a text editor open and review the install.log file in 
your installation folder to see if there are any apparent 
problems with the installation structure. (You can re-run 
Setup if necessary to re-install.)
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• Try using the Agilent License Information Tool, which is 
available to check your environment variable settings, 
display your license.lic file, and show your license and server 
status. Refer to “Using the Agilent License Information Tool” 
on page 59 for more information.

• Make sure a directory exists for temporary IC-CAP files. 
Temporary files are stored in the directory defined by the 
ICCAP_TMP variable. If ICCAP_TMP is not defined, 
temporary files are stored in the TMP directory. If the TMP 
directory does not exist, temporary files are stored in the 
TEMP directory. 

If you cannot find the problem, run IC-CAP in verbose (debug) 
mode and contact Technical Support to help pinpoint the 
problem. 
Running IC-CAP in Verbose Mode 
 

IC-CAP 2008 can be started in verbose (debug) mode to display 
more information about what is happening as IC-CAP runs. This 
extra information can be very useful to debug a problem with 
IC-CAP both at startup and in general operation. In verbose 
mode, IC-CAP writes a log file to the root folder of your PC’s 
system disk. Typically, this is:

C:\iccap_daemon.log

The iccap_daemon.log file can be sent by e-mail to Agilent 
EEsof EDA Technical Support for assistance.

To start IC-CAP in verbose mode, do the following:

1 Open your Windows Explorer.

2 Navigate to the bin folder in the IC-CAP installation folder. 
For example,

3 C:\ICCAP_2008\bin

4 Double click on the iccap_verbose.bat file.

This will start IC-CAP. You will notice some extra message 
windows as IC-CAP starts. Just click OK on each of the 
windows. Run IC-CAP until the problem you are trying to debug 
occurs, then take a look at the iccap_daemon.log file for errors.
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If you can’t locate the cause of the problem based on the 
contents of iccap_daemon.log, please contact Agilent EEsof 
EDA Technical Support and e-mail the iccap_daemon.log file to 
the assigned support engineer.
Licenses Stop Working
The FLEXnet software must be able to read the ethernet 
address of your LAN card for this to work properly. If you 
only have the TCP/IP protocol loaded, then FLEXnet will be 
unable to read the ethernet address and IC-CAP will not work.

You must have the NWLink IPX/SPX protocol loaded in addition 
to the TCP/IP protocol.

To load the NWLink IPX/SPX protocol in Windows, do the 
following:

1 Choose Start > Settings > Control Panel

2 In Control Panel, double-click on Network

3 In the Network dialog box, select the Protocols tab.

4 Click on the Add button.

5 Select NWLink IPX/SPX Compatible Transport from the list that 
appears and click OK. 

6 The protocol will be loaded. Once it is complete, select OK 
until out of the Network dialog box. 

7 To complete this procedure, reboot your PC.
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Following are some frequently asked questions about 
installation of IC-CAP programs on the PC.
Check the Nodelock ID of My Hardware Key
You need the nodelock ID of your hardware security key to get 
codewords from Agilent EEsof. It might also be useful to access 
this information when you place a call to Technical Support. 
There are two ways to check this:

• Before you install the hardware key on your PC, you can read 
the id directly from the key.

• If you have installed the hardware key on your PC, and have 
also already installed your codewords and the FLEXnet 
software, enter a command to check the nodelock id:
lmutil lmhostid -flexid
 
Delete All Installed Files
You don’t have to uninstall all files before you run the Setup 
installation again. Any new installation supersedes previous 
installations. However, the Uninstaller is useful whenever you 
want to make sure you have deleted all installed IC-CAP files, 
including registry entries.

To run the Uninstaller program:

1 Close all IC-CAP applications.

2 Select Start > Programs > IC-CAP 2008 PC > Uninstall IC-CAP 2008 
PC.

3 Answer yes to the prompt that asks whether you want to 
remove all IC-CAP applications and components.

4 When the uninstall process is complete, a prompt will 
indicate when the uninstall process is complete. Click OK to 
dismiss the dialog box.
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Change the Home Directory

NOTE Be sure you have exited all applications before running the Uninstaller 
program. If you have not, it is possible you will get errors upon re-installing 
IC-CAP. If these errors occur, reboot your computer and start the new 
installation again, or search for and end the lingering application(s) 
through the Windows Task Manager and start the new installation again.
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You can change the IC-CAP home directory by setting an 
environment variable named HOME or by changing the value 
listed in the registry for your IC-CAP home directory. If you set 
an environment variable named HOME, then IC-CAP uses that 
before the value listed in the registry.

To change the value listed in the registry for your IC-CAP home 
directory:

1 Select Start > Run. 

Type regedt32.exe

Click OK.

2 Inside the registry editor, find the folder or window titled 
HKEY_LOCAL_MACHINE on Local Machine. Select Software 
> Agilent > IC-CAP > 6.2 > eeenv. You will see a registry entry 
called

HOME: C:\users\default. 

(This is only true if you accepted the default startup folder 
during installation.)

3 Double-click this entry to open the string editor. Change this 
to reflect the path of your new home directory.

4 Change the Start directory of the IC-CAP Main window's file 
browser. Select the following:

Start > Settings > Taskbar & Start Menu Programs > Advanced > 
Advanced.

This opens the Explorer window.

5 On the right side of the Explorer window, double-click the 
Programs icon. 
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6 Open the IC-CAP 2008 PC icon. This displays the shortcuts to 
IC-CAP executable.

7 Right-click the IC-CAP icon and choose Properties

8 Choose the Shortcut tab. 

9 Change the field Start in: to reflect the path of your new 
home directory.
Ensure Hard Disk Storage Efficiency
 

This section provides an overview of the effects different types 
of file systems and different partition sizes have on the disk 
space required for installation of your IC-CAP application. 

See the table below for definitions of some important storage 
terminology.

An IC-CAP installation typically contains thousands of files. 
Although many of these files are only a few kilobytes in size, 
they can occupy a lot more disk space than their individual 
sizes suggest. For instance, it is not uncommon for a 1 kilobyte 
file to occupy 32 kilobytes of space. 

Table 2 Storage Terminology

sector The smallest unit of disk space that the hardware can read 
or write to, and it equals 512 bytes.

cluster A group of one or more contiguous sectors and is the 
smallest unit that a file system can allocate (hence it is also 
referred to as an allocation unit). For partitions larger than 
16 MB, there are normally 4, 8, 16, 32, or 64 sectors per 
cluster. The number of sectors per cluster is determined 
when the hard disk is formatted.

file system The means used by an operating system to store and 
retrieve files from a hard disk.

partition A logical hard disk and appears on a PC as having a unique 
drive letter such as C:\. A physical hard disk can be divided 
into one or more partitions.
on Guide 67



68

3 Using IC-CAP on Windows Systems
 

The amount of space occupied will depend on the type of file 
system that IC-CAP is installed on and the size of that 
particular disk partition. Identical installations can differ in 
space requirements by as much as 300% between different file 
systems. 

Adding a new hard disk is a relatively inexpensive and 
common way to compensate for poor hard disk storage 
efficiency. However there are other options that can provide 
additional space without adding hardware. Options include 
changing disk partition sizes, changing file system types, and 
using disk compression software.
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Agilent EEsof worldwide technical support is available Monday 
through Friday. The toll-free North America hotline is open 6:00 
am to 5:00 pm PT. Throughout Europe, the localized Online 
Technical Support Centers are open 8:30 am to 5:30 pm, local 
time; throughout Asia, the localized Customer Response 
Centers are open 9:00 am to 6:00 pm, local time.

The e-mail addresses for the various regions are listed below. 
However, for both the regional e-mail addresses and local 
telephone numbers for more than 25 countries, please refer to 
the Agilent EEsof Web site at

http://www.agilent.com/find/eesof/

North America 

Phone: 1 800 47 EEsof (473-3763) · Fax: 818-879-6465

e-mail: eesof_support@agilent.com 

Europe: e-mail: eesof-europe_support@agilent.com 

Japan: e-mail: eesof-japan_support@agilent.com

Korea: e-mail: eesof_korea@agilent.com

Asia: e-mail: eesof-asia_support@agilent.com
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Installing IC-CAP on UNIX Systems

Before You Begin 72

Installing IC-CAP 80

Installing to Multiple Disk Partitions or Directories 89

Using Multiple IC-CAP Versions 90

This chapter describes how to install IC-CAP on Solaris and 
Linux. To install IC-CAP on Windows, see Chapter 1, “Installing 
IC-CAP on Windows Systems.”
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Before you begin, please take the time to go over the guidelines 
for installing IC-CAP on UNIX systems. For last-minute program 
and documentation information, refer to the Release Notes 
document on our website at:

http://www.agilent.com/find/eesof-docs/

Choose IC-CAP 2008 > Release Notes.
Note the Changes in IC-CAP 2008

NOTE If you have systems running older versions of IC-CAP, see the following 
table for a brief description of changes in the latest IC-CAP versions and 
their impact on systems with older versions installed.
Table 3 Changes in IC-CAP 2008

Description and Reference to Details Version Introduced and Impact

Supported platforms changed.
See “Check the UNIX System 
Requirements”.

IC-CAP 2008
The following platforms are no longer 
supported: HP-UX, Solaris 8, Solaris 9, 
and Red Hat Linux WS 3.x. Redhat 
Enterprise 4.0 is now supported.

Required processor changed.
See “Check the UNIX System 
Requirements”.

IC-CAP 2008
Intel Pentium® 4 or better, or AMD XP 
3000 or better is now required for 
Linux.

Required RAM changed.
See “Check the UNIX System 
Requirements”.

IC-CAP 2008
1 GB RAM is now the recommended 
minimum. 

Required hard disk space increased.
See “Check the UNIX System 
Requirements”.

IC-CAP 2008
1 GB is now required for installation,
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Supported compilers changed. 
See “Check the UNIX System 
Requirements”.

IC-CAP 2008 
SunStudio 11 and gcc 4.1.1 are now 
supported.

Support for downloading installation 
images added. 
See “Installing IC-CAP”.

IC-CAP 2008 
Installation images available for 
download. 

The version for the license server 
(lmgrd) has changed to FLEXnet 11.4.1 
from FLEXnet 10.8. 
See “Installing Licenses”.

IC-CAP 2008 
Impacts all systems, hardware keys, 
license servers, and license 
administration scripts. 

The codeword version changed to 2.7 
from 2.35. 
See “Installing Licenses”,

IC-CAP 2008 
You must obtain new FLEXnet license 
codewords from Agilent EEsof EDA. 

Table 3 Changes in IC-CAP 2008

Description and Reference to Details Version Introduced and Impact
 

Check the UNIX System Requirements 
Be sure your hardware and software configuration meets the 
following minimum hardware and system requirements to run 
IC-CAP, including RAM, disk space, operating systems, etc. Keep 
in mind that minimum requirements are just that, and they may 
not provide adequate performance and responsiveness.
Requirement Solaris Workstation Linux Workstation

Operating System (see “” 
on page 75)

Solaris 10 (see “Solaris 10” on page 75) Redhat Enterprise 4.0 (see “Red Hat Linux Details” 
on page 75)

Displays High-resolution color only (Super VGA, 1024x768, 15-inch monitor minimum) (at least 1280x1024 
required for Extraction packages).

Processor IC-CAP is not supported on Intel 
Itanium-based workstations. If linking to 
3rd party Simulators, refer to Simulator 
requirements as well.

Intel Pentium® 4 or better, or AMD XP 3000 or 
better. If linking to 3rd party Simulators, refer to 
Simulator requirements as well.
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RAM 1 GB RAM recommended minimum. Additional RAM up to 2 GB will improve performance. Since 
IC-CAP is compiled on a 32-bit operating system, its processes cannot use more than 2 GB 
regardless of the maximum addressable memory available on your system. If linking to 3rd party 
Simulators, refer to Simulator requirements as well.

Swap Space 200 MBytes recommended minimum, increased swap space may be required for larger model 
files.

Hard Disk 1 GB required for installation,

Web Browser IC-CAP documentation is HTML-based and displayed via a web browser. Netscape version 4.5 or 
higher is required. 
Mozilla 1.7 or Firefox 1.5.0.4 or better are the recommended web browsers. To view the pdf files, 
Acrobat Reader 5.0 or higher is recommended.
Java Virtual Machine and JavaScript must be enabled on your browser for the documentation to 
appear correctly. You can use your browser’s internal Java support or download and install a 
Java plug-in. If you install a Java plug-in, the minimum recommended version is Sun Java 
Plug-in 1.3.

Security Device An IC-CAP software codeword is locked 
to an individual computer ID number. 

IC-CAP software codewords are locked to an 
external device (FLEXid hardware security key) 
attached to the PC's USB port or locked to a PC's 
LAN ethernet card.

Supported Printer/ 
Plotters

IC-CAP uses Xprinter for all PostScript, HPGL2 and PCL printing. For a complete list of output 
devices supported with Xprinter, consult the text file called filename_map.txt, located in the 
directory path: <installation directory>/xprinter/ppds. For instructions on UNIX printing and 
plotting, refer to Chapter 9,“Printing and Plotting” in the User’s Guide.

Supported Media Type CD-ROM or high speed internet access required for program installation.

Window Manager Motif V.1.1/1.2 Open Windows 3.0, or 
CDE

KDE or GNOME

Compiler required for 
userc customization

C++ and CC:
SunStudio 11

C++:
gcc Version 4.1.1

Compiler required for 
adding custom 
instrument drivers

C++ and CC:
SunStudio 11 

C++:
gcc Version 4.1.1

Requirement Solaris Workstation Linux Workstation
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Operating Systems Details

Solaris Details Solaris operating systems are not supported on Intel-compatible chips. 
Solaris requires the following patches (exact patch numbers may change as new patches 
are issued): 
You can find patches at http://sunsolve.sun.com/pub-cgi/show.pl?target=patchpage 

Solaris 10 119689-06 (libc.so.1 Patch) 
117461-08 (ld patch) 
118822-27 (kernel patch) 
118707-04 (Expert3D IFB Graphics Patch) 
118712-08 (Sun XVR-100 Graphics Accelerator Patch) 
118711-02 (M64 Graphics Patch) 
118708-11 (Sun XVR-1200 Graphics Accelerator Patch)

Red Hat Linux Details For instrument connectivity, RHEL 4 Update 3 (kernel-2.6.9-34.el, 2.6.9-34.elsmp) is 
required. The following is the minimum RPM and RPM version recommendation based 
on RHEL 4 Update 1 — the required RPM version for your system may vary:

Linux RHEL 4.0 kernel-2.6.9-11.EL 
glibc-2.3.4-2.9 
elfutils-0.97.5 
elfutils-libelf-0.97.5
IC-CAP Installation and Customizati
Checking the Operating System

To determine the version that you are currently running, at the 
system prompt type:

uname -r (All UNIX platforms)
Check the Supported Instrument Interfaces
If you are using IC-CAP with an Agilent GPIB interface, install 
the interface and its driver according to the instructions 
supplied with the interface.

Description Part Number

Supported GPIB Interfaces on SUN OS Workstations

Agilent LAN/GPIB Gateway Interface E2050A1/B1, 2, 3

National Instruments PCI-GPIB card and NI-488.2M Software
NI-488.2M Software Only

777462-01
778599-01
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1 These are discontinued products.
2 Typically the LAN has some impact on speed; therefore, the E2050A/B will 

most likely be somewhat slower than a card.
3 E2050A/B driver built into IC-CAP.

National Instruments SB-GPIB card and NI-488.2M Software 776789-01

Supported GPIB Interfaces on Linux OS Workstations

Agilent LAN/GPIB Gateway Interface
TAMS IO Library

E5810A 2

82091

TAMS High Speed PCI GPIB and TAMS IO Library
TAMS IO Library Only

81488
82091

TAMS PCI and TAMS IO Library
TAMS IO Library Only

80488
82091

TAMS USB GPIB and TAMS IO Library 
TAMS IO Library Only 

83488
82091

Description Part Number
 

Get Codewords for IC-CAP 2008

NOTE For information on the TAMS SICL IO Libraries, please visit the TAMS - 
Test and Measurement Systems, Inc. website at: 

http://www.tamsinc.com/

NOTE For the latest information refer to this manual on our website at: 
http://www.agilent.com/find/eesof-docs.
You must obtain new FLEXnet license codewords to run 
IC-CAP 2008. 

You may request codewords via the Web at:

http://www.agilent.com/find/eesof-support/

Choose Request Codeword.

The codewords are emailed to you in a license file called 
license.lic. 
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If you do not have a hardware key, contact Agilent EEsof 
Business Support at 1-800-507-6274.

For details on both methods of securing codewords refer to 
Chapter 5, “Setting up Licenses on UNIX Systems.”

Special License Issues 

Please consider the following issues before requesting a license. 

Linux Systems If you will be using your LAN card's Ethernet 
ID to run the FLEXnet licensing system on your PC and you 
have more than one network card (such as a permanent LAN 
card and a removable WLAN card) inform your Agilent sales 
representative to assist you in selecting the correct ID when you 
request licenses. Use the following command to read the ID, and 
copy the address returned for Ethernet HWAddr. Then ask the 
Agilent EEsof Business Support to tie this ID to your IC-CAP 
codewords when you submit your Codeword Request Form. 

/sbin/ifconfig
 
Check Available Memory
Minimum recommended memory is 1 GB. More memory results 
in better overall system performance for some design work. 

Solaris Systems

To check the amount of memory on your system, enter the 
following command at a command prompt: 

/usr/bin/dmesg | more

Look for the avail mem= and mem= lines. 

This command lists the messages displayed during the last boot 
of the system.

Red Hat Linux Systems 

To check the amount of memory on your system, enter the 
following command at a command prompt: 

/bin/dmesg 
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Look for the Memory line which includes the amount of 
available memory. 
Check Available Disk Space
The amount of disk space required depends on the IC-CAP 
products that you wish to install. A minimum of 500 MBytes of 
available disk space is required to install all IC-CAP products. 
To display the available disk space, at the prompt enter the 
command for the workstation you are using:

Workstation Command

Solaris df -k

Red Hat Linux df -k
 

NOTE IC-CAP requires at least 20-30 MB of free disk space under /tmp and 
var/tmp to work properly.
Checking Swap Space

The recommended minimum swap space is 100 MB. Very large 
designs could require more. To check the current amount of 
swap space on your system, enter one of the following:

Defining an Install Location

Be sure you have permissions to write to the disk drive on 
which you want to install IC-CAP. 

• You do not need to install as root, although you may need 
root privileges to mount and unmount the installation 
CD-ROMs. 

Workstation Command

Solaris /usr/sbin/swap -s

Red Hat Linux /usr/bin/free -t
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• If installed as root, all IC-CAP files should have at least read 
permission for all users.

You can re-run the installation program to install components 
you chose not to install the first time through. 

For details on install steps and options, refer to “Installation 
Steps” on page 81.
 

NOTE The installation program does not support cross-platform installations. 
Please be sure to use the correct platform-specific installation image for 
your system.
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IC-CAP can be installed on a UNIX system using either the 
IC-CAP installation CD or by downloading IC-CAP installation 
images from the Agilent EEsof Knowledge Center website:

http://www.agilent.com/find/eesof-knowledgecenter

Use the following information for installing IC-CAP on a UNIX 
system. For last-minute program and documentation 
information, refer to the Release Notes document on our 
website at:

http://www.agilent.com/find/eesof-docs/

Choose IC-CAP 2008 > Release Notes.

Install program files

Add codewords to license 
file and start FLEXnet

Launch IC-CAP

Obtain Codewords

Mount Installation CD or 
download image

Run setup program
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Use the following steps for installing IC-CAP on UNIX systems. 
If you have not done so, please review “Before You Begin” on 
page 72. Also, if you installed a pre-release Beta version of 
IC-CAP, you should uninstall it before loading this release.
NOTE The installation program does not support cross-platform installations. 
Please be sure to use the correct platform-specific installation image for 
your system.
 

To install IC-CAP on UNIX systems:

1 Log onto the system using an account that has permissions to 
write to the disk to which you want to install.

2 If you are installing from a CD-ROM, mount the IC-CAP 
CD-ROM. Mounting a CD-ROM file system on a UNIX system 
requires root or super-user privileges on most systems.

The typical mount point, or directory, for a CD-ROM is 
/cdrom. This may be different on your system. The mount 
point directory must exist before you can mount the 
CD-ROM. To create a /cdrom directory, type:
mkdir /cdrom

To mount the Program CD-ROM, run the command for your 
system:
mount -rt hsfs /dev/sr0 /cdrom (SunOS 5.x)
mount -t iso9660 /dev/cdrom /cdrom (Linux)

Once the Program CD-ROM is mounted, exit from being root 
before completing the rest of the installation procedure if you 
do not want to install as root.

3 If you are installing from a downloaded image, download 
then untar the appropriate IC-CAP installation image for 
your platform from the Agilent EEsof Knowledge Center 
website:

http://www.agilent.com/find/eesof-knowledgecenter

For example to untar the file on Linux:

tar xf iccap640rday_linux_x86.tar
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4 Change directory to the Program CD-ROM or to the path of 
the extracted tar files.

cd /cdrom

5 To start the installation program type:
./SETUP.SH
 

NOTE If you do not have a fully compliant X display available, you can run the 
installation in console mode. To start the program in console mode, add 
the -console argument to the SETUP command. For example, type: 

./SETUP.SH -console

NOTE The Sun File Manager is not recommended to invoke SETUP. If you use the 
file manager to invoke SETUP, a new terminal window is created. If you 
select Q to quit the installation, the terminal window remains open until 
you close it by pressing Ctrl-C.

NOTE If you are running Netscape, or another program that uses a lot of color 
resources, you should shut it down before starting the installation.
6 At the Welcome screen, choose:

• Next to read the License Agreement. This is a usage 
agreement and is not related to the license codewords 
required to run the software. You must accept the 
agreement to continue with the installation. This appears 
only when you run Setup the first time or after 
uninstalling IC-CAP.

7 At the License Agreement screen, after reviewing the 
agreement, choose either:

• I accept the terms of the license agreement

• I do not accept the terms of the license agreement

then click Next to continue with the setup or Cancel to end the 
setup program.

8 At the Installation Directory screen, choose:
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• Next to install to the default destination. 

• Browse to specify a different destination folder. If you 
specify a folder that does not exist, the installation 
program will ask if you want to create it. 

9 At the Summary Information screen, review your choices 
then choose:

• Back to access previous screens to verify entries and make 
changes. This screen appears again if you go back to make 
other choices.

• Install to begin the installation.

• Cancel to exit the Setup without completing the 
installation.

After you click Install, the program starts copying files. The 
status screen displays the files being installed and shows the 
installation progress.

10 After reading the information about how to obtain licenses or 
codewords to run IC-CAP, click Finish.

11 If you installed from a CD-ROM, unmount the installation 
CD-ROM:
cd /
umount /cdrom
NOTE You will need to be in the root directory to unmount the CD-ROM. If you are 
running Solaris and vold is active, you can type the following command to 
unmount the CD-ROM: eject cdrom.
12 Use the FLEXnet security codewords from Agilent EEsof to 
create a license.lic file with the correct SERVER and 
VENDOR line configurations.

13 Place the license.lic file in the licenses sub-directory of your 
IC-CAP installation directory and start FLEXnet to enable 
your codewords. (Refer to Chapter 5, “Setting up Licenses on 
UNIX Systems.”)
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The contents of the IC-CAP CD or downloaded and untarred 
installation image can be copied to a file server enabling you to 
install IC-CAP from this file server. This arrangement is useful 
for doing silent installations (see “Silent Installations” on 
page 84). The following steps explain how to set up the file 
server and run the installation.

1 If installing from a CD, insert the IC-CAP installation CD into 
the file server’s CD-ROM drive and mount the Program 
CD-ROM by running the command for your system:
mount -rt hsfs /dev/sr0 /cdrom (SunOS 5.x)
mount -t iso9660 /dev/cdrom /cdrom (Linux)

2 Either copy the contents of the CD into a folder or untar the 
downloaded installation image into a folder.
cd /mnt/cdrom
cp -r * /local/ICCAP2008_image

3 To start the installation program type:
./SETUP.SH

You may run the normal installation described in 
“Installation Steps” on page 81, or the silent installation 
described in “Silent Installations” on page 84.
Silent Installations
The InstallShield program provided with IC-CAP supports a 
silent installation. A normal (non-silent) installation receives 
the necessary input from the person installing the software in 
the form of responses to prompts in dialog boxes. However, a 
silent installation does not display prompts for inputs. Instead, 
a silent installation gets inputs from a response file.

Silent Installation Overview

To set up and run a silent installation on a UNIX system for 
IC-CAP 2008:

1 On a server, copy the contents of the IC-CAP installation 
image (from CD or downloaded and untarred) to a folder. 
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Details about setting up a file server are described in 
“Installing from a File Server” on page 84.

2 On clients, run the SETUP using arguments for a silent 
installation, including the path and file name of the response 
file.

3 If needed, run a silent uninstallation to remove IC-CAP from 
client machines.

Response File Contents

The response file provides the inputs automatically during 
silent installations. The command to execute a silent 
installation includes the path and file name of the response file. 
Using our example location for the installation contents, the 
sample response.txt file is located in the 
local/ICCAP2008_image/silent folder.

The response.txt file supplies the following inputs requested by 
the installation program:

• Installs IC-CAP 2008 into the current folder.

• Sets the home folder to the current folder.

If you want to change these settings, copy and edit the 
response.txt file being careful to change only the settings in 
question to avoid corrupting the file. To change the installation 
folder, change -P installLocation and -V IS_DESTINATION to a 
new path.

Running a Silent Installation

To run a silent installation:

1 Verify that IC-CAP 2008 has not already been installed. There 
should not be a iccap2008 folder since the silent installation 
process is not expecting it to be there. If IC-CAP has been 
installed, uninstall it.

2 Change to the /local/ICCAP2008_image folder.

3 To start the installation program type ./SETUP.SH followed 
by the full path for the response file and the silent 
installation option. For example:
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cd /local/ICCAP2008_image
./SETUP.SH -options "tmp/response.txt" -silent

4 After waiting 3 to 5 minutes for the installation process to 
finish, verify that the installation process is done by checking 
that the _uninst directory is located under the installation 
directory.

Running a Silent Uninstallation

When you need to run a silent uninstallation, use the sample 
response file, uninst_response.txt. Using our example location 
for the installation contents, the uninst_response.txt file is 
located in the /local/ICCAP2008_image/silent folder.

To run a silent uninstallation:

1 Change to the folder containing the uninst_response.txt file.
cd /local/ICCAP2008_image/silent

2 Copy the uninst_response.txt file to the folder tmp:
cp uninst_response.txt /tmp

3 Change to the _uninst subfolder in the IC-CAP installation 
folder:
cd local/iccap2008/_uninst

4 Run the uninstaller:
./uninstaller.bin -options "tmp/uninst_response.txt" 
-silent

This process opens a progress dialog box. When the dialog box 
closes, the process is done.

Troubleshooting

The most effective way to troubleshoot errors with the silent 
install/uninstall process is to run the same type of installation 
in normal or visual mode.
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Configure the user accounts that will run IC-CAP as follows:

C-Shell:

Add the following at the end of $HOME/.cshrc:
setenv ICCAP_ROOT <install_directory> 
setenv AGILEESOFD_LICENSE_FILE <path_to_license_file>

Default: $ICCAP_ROOT/licenses/license.lic
set path = ( . $ICCAP_ROOT/bin $path )

Bourne or Korn Shell:

Add the following at the end of $HOME/.profile:
ICCAP_ROOT=<install_directory>
AGILEESOFD_LICENSE_FILE=<path_to_license_file>

Default: $ICCAP_ROOT/licenses/license.lic
PATH=.:$ICCAP_ROOT/bin:$PATH
export ICCAP_ROOT AGILEESOFD_LICENSE_FILE PATH
 
NOTE If you are running Common Desktop Environment (CDE), your user account 
may be using $HOME/.dtprofile to set up your user account instead of 
.cshrc or .profile. The .dtprofile files contain a line that can be 
uncommented to activate the use of .cshrc or .profile. Please see your 
system administrator or CDE documentation for details.
Once the user accounts are configured, each user should log in 
and verify that the new environment variables are set. Type the 
env command and check that ICCAP_ROOT and 
AGILEESOFD_LICENSE_FILE are set and that PATH contains a 
path to the IC-CAP bin subdirectory. 

If you installed IC-CAP as root, the ownership of directories and 
files will be set to user id 1313 and group id 22. To change this, 
enter:

cd $ICCAP_ROOT
chown -R root *
chgrp -R sys *
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Setting the Display

If you plan to run IC-CAP from a remote computer and you want 
the display to appear on your local machine, you will need to set 
the DISPLAY environment variable:

setenv DISPLAY <my_hostname>: 0.0 (C-Shell)
DISPLAY = <my_hostname>: 0.0 (Korn Shell, Bourne Shell)
export DISPLAY

For details on using the Sun Ray appliance, refer to the Sun 
website at: http://www.sun.com/sunray/index.html
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Installing to Multiple Disk Partitions or Directories
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If you do not have a single partition large enough to hold the 
entire IC-CAP installation, you can spread the installation 
across partitions using symbolic or soft links. The symbolic 
links are created before installation to redirect files to other 
partitions.

For example, suppose you want to install IC-CAP with most of 
the software installed in /usr/local/iccap2008, but you want the 
example projects to be installed to /disk2 due to lack of disk 
space in the /usr partition. Before starting the installation 
process you would do the following:

1 Create the main installation directory:
cd /usr/local
mkdir iccap2008

2 Create the directory that will hold the example files on 
/disk2:
cd /disk2
mkdir iccap_examples

3 Create a link named examples in the main installation 
directory that points to the /disk2/iccap_examples directory:
cd /urs/local/iccap2008
ln -s /disk2/iccap_examples examples

4 Begin the installation process. When the examples are 
installed, the example projects will follow the 
/usr/local/iccap2008/examples link to 
/disk2/iccap_examples.

Following is a list of the larger directory names for IC-CAP, 
along with approximate sizes. The doc directory can be 
re-directed to another disk partition as shown above for the 
examples directory. The sizes shown are for a complete 
installation.

Directory Name Approximate Size

examples 115 Megabytes

doc 86 Megabytes
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Use the following instructions to maintain and run more than 
one version of IC-CAP (such as version 2006 and 2008). Keep a 
separate $HOME directory for each version of IC-CAP to help in 
structuring all the files and prevent problems that may arise if 
the configuration files are shared between multiple 
installations. The $HOME directory is where all your projects 
are kept.
Setting the HOME Environment Variable
You need to specify the variable $HOME separately for each 
version of IC-CAP that you want to run. You can set up two 
directories from which you can run different scripts to launch 
the version of IC-CAP you want.

Below are some example scripts. Please change them to match 
your system.

Script for IC-CAP 2006

#!/bin/ksh
#
# Script for starting IC-CAP 2006 on UNIX.
HOME=/users/jdoe/iccap2006
ICCAP_ROOT=/utils/eesof/iccap2006
PATH=$ICCAP_ROOT/bin:$PATH
export HOME ICCAP_ROOT PATH
iccap

Script for IC-CAP 2008

#!/bin/ksh
#
# Script for starting IC-CAP 2008 on UNIX.
cd /users/jdoe/iccap2008
HOME=/users/jdoe/iccap2008
ICCAP_ROOT=/utils/eesof/iccap2008
PATH=$ICCAP_ROOT/bin:$PATH
export HOME ICCAP_ROOT PATH
iccap
IC-CAP Installation and Customization Guide



Agilent 85190A IC-CAP 2008
Installation and Customization Guide

 

5
Setting up Licenses on UNIX Systems

Installing Licenses 93

Special Licensing Needs 106
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Using the Agilent License Information Tool 121

Use the following information to set up licenses for IC-CAP 
on UNIX systems. After you install IC-CAP using the steps 
described in Chapter 4, “Installing IC-CAP on UNIX Systems,” 
you will need to set up the FLEXnet license manager and your 
IC-CAP license file (license.lic) before you can run IC-CAP.

IC-CAP uses Macrovision’s Flexible License Manager 
(FLEXnet) software for all software security configurations. 
When you run the IC-CAP Setup program, the FLEXnet 
software is installed at <installation folder>/licenses/bin 
where <installation folder> is the destination folder you 
specified when you ran Setup. 

For Linux systems, you can use one of the following 
methods to run the FLEXnet licensing system on your PC:

• Install a USB FLEXid hardware key.

• Read your LAN card’s ethernet ID. 

For information on installing a FLEXid hardware key, see 
the FLEXid_README.pdf file located in the doggle_sup 
directory on the IC-CAP installation image (CD or downloaded). 
This directory also contains the files needed to install a USB 
hardware key. For the most up-to-date files, contact your 
hardware key vendor.
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For details on using FLEXnet, refer to the Macrovision 
website at:

http://www.macrovision.com/support/by_catagory/Software
_Licensing.shtml
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Installing Licenses
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You must request and install new license codewords for 
IC-CAP 2008. To learn how to request codewords, see “Get 
Codewords for IC-CAP 2008” on page 76. To install and 
configure your new license file, complete the steps in the 
following sections.

Place License File

Provide Access to 
Licenses

Start License Server

Save License File

Edit License File
Installing a Hardware Key
One way to run the FLEXnet licensing system on your PC is 
to install the FLEXid hardware key (also called a dongle) on 
a parallel or USB port of your computer. In a node-locked 
environment, it is installed on the local machine. In a 
floating license environment, it is only required on the 
server machine.
NOTE Before you install the key, make a note of the hardware key ID number on 
the key. If you have not already received your security codewords from 
Agilent EEsof, you will need to provide this number for your Codeword 
Request Form.
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For information about linking your LAN card’s Ethernet ID 
to your IC-CAP codewords, see “Get Codewords for 
IC-CAP 2008” on page 76.
Save the License File
When you receive your codeword file from Agilent EEsof 
Business Support, it will be called license.lic. Save the 
license.lic file using the same filename. Most codewords are 
distributed by e-mail.
Edit the License File
Edit your license.lic file to correct the SERVER line and add 
information to the VENDOR line. Refer to “SERVER Line 
Guidelines” on page 96 and “VENDOR Line Guidelines” on 
page 97 for details. You can use the Agilent License Information 
Tool to check your environment variable settings, display your 
license.lic file, and show your license and server status. For 
details, refer to “Using the Agilent License Information Tool” on 
page 121.
NOTE Each line in the license.lic file must be a single continuous line with each 
field separated by a single space. You may line wrap lines using the 
backslash ('\') character, but be very careful not to add a space after the 
backslash. Otherwise, you can remove the backslash and make each 
INCREMENT line one continuous line.
Node-Locked File

The codeword file must follow the format shown in the 
following example. This example is from a node-locked file 
where the quantity, displayed on the first line after the date, 
is typically “1”: 
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SERVER lapin 000086XXXXXX
VENDOR agileesofd
INCREMENT dev_bjt_gp_ee agileesofd 2.7 19-apr-2008 1 \

VENDOR_STRING="000086XXXXXX : SYAQRDS F1AQCOM CNEXTBD FBLCHLO \
WYGJYZD WTFLQZD WQYQBHI EFZ" HOSTID=000086XXXXXX \
START=20-oct-2005 SIGN="00CF 6970 1933 85B7 1D14 AF45 A3FE \
CB12 8E82 3BDC BD03 CF91 4618 77D4 0CCC B721 391C E439 A3CD \
923A 549A"

INCREMENT dev_bsim3 agileesofd 2.7 19-apr-2008 1 \
VENDOR_STRING="000086XXXXXX : WVRFWQG PJEL1QG AUYILYS XUYGJCY \
L2WEYGO LSRXYBG PHEUL" HOSTID=000086XXXXXX START=20-oct-2005 \
SIGN="0284 47D1 DBF7 041F 3F0D 9507 D914 DC36 B670 FE4D 2601 \
C880 BCCE 5510 D478 5F44 964C 9BBB 17AD 8F99 5BC4"
IC-CAP Installation and Customizati
Floating-License File

The codeword file for a floating license is the same as the 
previous node-locked file example, with two exceptions: 
There is no HOSTID identifier in a floating license and the 
quantity can be any number, one or more, depending upon 
the number of licenses you own. Below is a sample of a 
section of a floating-license file: 
 
SERVER A0049626 0008XXOOXXOO
VENDOR agileesofd
INCREMENT dev_bjt_gp_ee agileesofd 2.7 19-apr-2008 2 \

VENDOR_STRING="0008XXOOXXOO : SYAQRDS F1AQCOM CNEXTBD FBLCHLO \
WYGJYZD WTFLQZD WQYQBHI EFZ" START=20-oct-2005 SIGN="030F 496F \
0869 F6A0 FD20 66E6 1DBF A981 22C3 4143 4B02 A946 49DC DB3B \
A791 8140 ACEB 3211 7AFE 5FFD 7143"

INCREMENT dev_bsim3 agileesofd 2.7 19-apr-2008 2 \
VENDOR_STRING="0008XXOOXXOO : WVRFWQG PJEL1QG AUYILYS XUYGJCY \
L2WEYGO LSRXYBG PHEUL" START=20-oct-2005 SIGN="00E7 7925 AEFF \
91D3 0595 5457 4C86 E596 20AB 38E8 4001 3A0D 30F3 0E13 C6C4 \
150D 5808 DA83 6AC1 8467 1AD2"
SERVER Line Format

The SERVER line, by default, has the following format:

SERVER hostname hostid [port]

where:

hostname is the network name of the machine whose 
hostid appears in field 3 of the SERVER line.
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hostid is the unique machine ID of the license server 
machine running Solaris. On Linux, it is either the unique 
machine ID of the license server machine or the LAN card's 
Ethernet ID. Use one of the following commands to read the 
hostid for your system:

port is an optional entry naming the TCP/IP port number 
that the license server will listen at for license requests. 
An example port number is 27000. 

SERVER Line Guidelines

• Your license file should contain an odd number of 
SERVER lines; for example, 1 or 3. If you have 3 SERVER 
lines, the first SERVER is the primary license server and 
the other two are backup servers. All three SERVER lines 
must use the same port number.

• You may only change the hostname and the optional port 
number fields. 

• Adding or removing SERVER lines requires a new 
license.lic file.

• By default, Agilent EEsof sets hostname to unknown. The 
SERVER line does not contain a port address. FLEXnet 
software assigns a port address in the range of 27000 to 
27009. The examples in this manual use a port address of 
27000, but your license file may differ. If you do not want 
to use the port address assigned by FLEXnet, specify any 
other unused port number for your network.

Operating System Command

Solaris /bin/hostname

Linux /bin/hostname

Operating System Command

Solaris /bin/hostid

Linux /sbin/ifconfig
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NOTE Enter a specific port address on the SERVER line for improved license 
check-out performance. You may enter a port address outside the range of 
27000 to 27009, as long as the address is not used elsewhere. Also, set the 
environment variable AGILEESOFD_LICENSE_FILE as described in “Place 
License File” on page 99.
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• If the hostid is wrong, or changes for some reason, you 
will need to request a new license.lic file from Agilent 
EEsof.

Here are examples of properly configured SERVER lines:
SERVER joshua 2072EFE45 (default)
SERVER isaiah 20472A3D3 27000 (optional)

VENDOR Line Format

The VENDOR line, by default, has the following format:
VENDOR daemon_name

where

daemon_name is the name of the vendor daemon.

Optionally, you may specify a path to the vendor daemon 
and a path to the FLEXnet options file, for example:

VENDOR agileesofd \
/my_install_dir/licenses/vendors/agileesofd \
/my_install_dir/licenses/agileesofd.opt

VENDOR Line Guidelines

• During installation of IC-CAP, the vendor daemon is 
installed in the $ICCAP_ROOT/licenses/vendors and 
$ICCAP_ROOT/licenses/bin directories.

• The daemon_name must be agileesofd.

• The path to the options file is intentionally left blank. If 
you want to use FLEXnet options, you must add a full 
path to your option file. To learn about FLEXnet options, 
see “Using FLEXnet Options” on page 106. If the file does not 
exist and this option is not blank, a warning message will 
appear in the flex.log file.

• Here is an example of a properly configured VENDOR line 
(without an options file):
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VENDOR agileesofd /my_inst_dir/licenses/vendors/agileesofd

INCREMENT Line Format

The INCREMENT lines must have the following format:

INCREMENT feature vendord ver exp num vendorstring 
hostid sign

where

feature is the name of the feature licensed by this line.

vendord is the name of the vendor daemon that will 
manage this feature.

ver is the version of the feature licensed by this line.

exp is the expiration date of this license.

num is the number of licenses this line enables.

vendorstring is the CPU ID of the primary license server.

hostid is an optional field. If this field exists, it is the 
hostid of the machine that this license is node-locked to. 
Only the machine whose hostid appears in this field may 
checkout this license.

sign is the encrypted codeword.

INCREMENT Line Guidelines

• None of the fields on the INCREMENT lines are editable. 
Any change made to any of the fields on an INCREMENT 
line will make that feature invalid. The only valid edit of 
an INCREMENT line is to add a backslash ('\') to line 
wrap the line. Be careful not to add an extra space 
between fields when using a backslash to line wrap an 
INCREMENT line.

• Here are two examples of valid INCREMENT lines. 

Floating license example:
INCREMENT dev_bjt_gp_ee agileesofd 2.7 19-apr-2008 2 \
VENDOR_STRING="00008XXOOXXO : SYAQRDS F1AQCOM CNEXTBD \
FBLCHLO WYGJYZD WTFLQZD WQYQBHI EFZ" START=20-oct-2005 \
SIGN="023E 6EC8 0EAD 7537 5072 CA30 C5F9 3DAE 73BC 3168 \
D601 453A F3BE F758 ACE2 4576 CE88 FB0E 8663 C8EE 918B"
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Node-locked license example:
INCREMENT dev_bjt_gp_ee agileesofd 2.7 19-apr-2008 1 \
VENDOR_STRING="000086XXXXXX : SYAQRDS F1AQCOM CNEXTBD \
FBLCHLO WYGJYZD WTFLQZD WQYQBHI EFZ" HOSTID=000086XXXXXX \
START=20-oct-2005 SIGN="00CF 6970 1933 85B7 1D14 AF45 \
A3FE CB12 8E82 3BDC BD03 CF91 4618 77D4 0CCC B721 391C \
E439 A3CD 923A 549A"

The backslash used to line wrap these two INCREMENT 
line examples is prefaced by a space and contains a 
carriage return immediately after it. The '\' character is 
the absolute last character of the line it is on.
Place License File
 

A copy of the license.lic file must be placed on all SERVER 
machine(s) listed in the license.lic file.

License Placement Guidelines

• The recommended location for the license.lic file is:
$ICCAP_ROOT/licenses/license.lic

• You might need root permission to copy the license.lic file 
into the IC-CAP installation directory if IC-CAP was 
installed by a user logged in as root.

• You can choose to locate the license.lic file someplace else 
on the SERVER machine(s). If you choose to do this, 
make sure that IC-CAP users properly set 
AGILEESOFD_LICENSE_FILE.

• Make sure that the license.lic file has at least read 
permission for all users:
cd $ICCAP_ROOT/licenses
chmod 555 license.lic

This command gives you read/executable permissions 
only.

• Place a copy of the $ICCAP_ROOT/license directory on all 
SERVER machines or custom install the FLEXnet license 
server on each machine.
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Use the following procedure and guidelines to start the license 
server, lmgrd, on the SERVER machine.
NOTE Be sure to use the following guidelines to update all existing license 
servers with the latest version of the FLEXnet software (e.g., lmgrd and 
lmutil). The software is installed with IC-CAP 2008. Using older versions 
may cause license-encryption errors, invalid hostid results, and 
unsupported feature errors.

Verify that all multiple and redundant servers are updated including any 
license administration scripts in use. Run lmutil directly from the 
IC-CAP 2008 installation location ($ICCAP_ROOT/licenses/bin) for 
information to help modify the scripts.

You will need to stop, then restart, the license server to make these 
updates.
Guidelines for Starting lmgrd 

• You only need to run lmgrd on the SERVER machine(s).

• If the SERVER machine(s) has IC-CAP installed on it, you 
will find the FLEXnet license manager daemon (lmgrd) in 
the $ICCAP_ROOT/licenses/bin directory. If the SERVER 
machine does not have IC-CAP installed, you can copy the 
$ICCAP_ROOT/licenses directory from the machine that 
has IC-CAP installed.

• IC-CAP installs version 11.4.1 of FLEXnet. Make sure you use 
the version 11.4.1 lmgrd and agileesofd supplied or a newer 
version of lmgrd. You can determine the version of lmgrd 
and agileesofd by typing the following commands:
cd $ICCAP_ROOT/licenses/bin
./lmgrd -v
cd $ICCAP_ROOT/licenses/vendors
./agileesofd -v

To start lmgrd:

Change the directory to where lmgrd resides on the SERVER 
machine and execute lmgrd. For example:
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cd $ICCAP_ROOT/licenses/bin
./lmgrd -c ../license.lic > ../flex.log

The login executing lmgrd must have full permissions to the 
licenses/bin directory and at least write permissions to the 
directory specified for flex.log.

All error, warning and status messages will be redirected to 
the flex.log file. After starting lmgrd, wait approximately 30 
seconds, then look at the contents of flex.log to see if there 
are any errors that need to be corrected.

To verify that the licenses are available:

Make sure that the flex.log file does not contain any errors, 
then run lmstat as follows:

cd $ICCAP_ROOT/licenses/bin
./lmutil lmstat  -a -c ../license.lic  | more

Or, you may launch the Agilent License Information Tool to 
do this. Refer to “Using the Agilent License Information Tool” 
on page 121 for more information.

If the licenses are available, you should see a listing similar 
to the following:
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Provide Access to Licenses

lmutil - Copyright (C) 1989-2004 Macrovision, Inc. All Rights 
Reserved
Flexible License Manager status on Thu 02/28/2008 07:39
License server status: 27000@joshua

License files on joshua: /iccap2008/licenses/bin/../license.lic:
joshua: license server UP (MASTER) v11.4.1 
Vendor daemon status (on joshua):
agileesofd: UP v11.4.1 
Feature usage info:
Users of ac_driver:  (Total of 3 licenses available)
Users of analysis:  (Total of 3 licenses available)
Users of curtice_statz_fet:  (Total of 3 licenses available)
Users of dc_driver:  (Total of 3 licenses available)
Users of gummel_poon_bjt:  (Total of 3 licenses available)
Users of hp_eebjt2:  (Total of 3 licenses available)
Users of hp_eefet3_eehemt1:  (Total of 3 licenses available)
Users of hp_root_diode:  (Total of 3 licenses available)
Users of hp_root_fet_femt:  (Total of 3 licenses available)
Users of hp_root_mos:  (Total of 3 licenses available)
Users of iccap_environment:  (Total of 3 licenses available)
Users of lcrz_driver:  (Total of 3 licenses available)
Users of noise_driver:  (Total of 3 licenses available)
Users of philips_mextram_bjt:  (Total of 3 licenses available)
Users of philips_mos_model_9:  (Total of 3 licenses available)
Users of pulsed_sys_driver:  (Total of 3 licenses available)
Users of statistical_modeling:(Total of 3 licenses available)
Users of time_domain_driver:  (Total of 3 licenses available)
Users of ucb_bsim3:  (Total of 3 licenses available)
Users of ucb_mos2_mos3:  (Total of 3 licenses available)
Users of vbic_bjt:  (Total of 3 licenses available)
102
Before attempting to start IC-CAP, you must configure each 
user’s login environment to allow access to the licenses on 
the SERVER machine(s). To do this you need to configure 
the environment variable named 
AGILEESOFD_LICENSE_FILE in the user's .profile or .cshrc.

For example:

C Shell:
setenv AGILEESOFD_LICENSE_FILE 
$ICCAP_ROOT/licenses/license.lic

Bourne/Korn Shell:
AGILEESOFD_LICENSE_FILE=$ICCAP_ROOT/licenses/license.lic
export AGILEESOFD_LICENSE_FILE

You can avoid the need to have a copy of the license.lic file 
directly on the machine running IC-CAP by setting 
AGILEESOFD_LICENSE_FILE as follows:
AGILEESOFD_LICENSE_FILE=<port>@<SERVER_hostname>
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where

port is the TCP port number from the SERVER line(s) of 
the license.lic file.

SERVER_hostname is the network name of a SERVER 
machine serving IC-CAP licenses. This must be a name 
that the SERVER is known by on the network. You should 
be able to successfully ping this name from the machine 
that will run IC-CAP.

Or, if your license server is set up to search for an available 
port, your AGILEESOFD_LICENSE_FILE should read:

AGILEESOFD_LICENSE_FILE=@<SERVER_hostname>

For example,

C Shell:
setenv AGILEESOFD_LICENSE_FILE 27000@joshua

OR
setenv AGILEESOFD_LICENSE_FILE @joshua

Bourne/Korn Shell:
AGILEESOFD_LICENSE_FILE=27000@joshua
export AGILEESOFD_LICENSE_FILE

OR
AGILEESOFD_LICENSE_FILE=@joshua
xport AGILEESOFD_LICENSE_FILE

The syntax to access multiple license servers is as follows.

C shell:
setenv AGILEESOFD_LICENSE_FILE
27000@server1:27000@server2:27000@server3

Bourne/Korn shell:
export AGILEESOFD_LICENSE_FILE=
27000@server1:27000@server2:27000@server3

However, in this case, “server” should be replaced by the 
actual license server name or IP address, and the “27000” 
may need to be changed to the actual port number on the 
license server. Note that the list of servers is separated by 
colons (:). For details on running FLEXnet-licensed products 
from multiple vendors refer to “Merging Multiple Vendor 
Licenses” on page 108.
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A Windows PC system can access the UNIX license server’s 
license.lic file in either of two ways:

• By copying the license.lic file from the UNIX license server to 
the PC’s $ICCAP_ROOT/licenses folder

• By setting the AGILEESOFD_LICENSE_FILE variable on 
the PC to point to the UNIX license server as follows:
set AGILEESOFD_LICENSE_FILE=<port>@<host>

For example:
set AGILEESOFD_LICENSE_FILE=27000@joshua

where 

27000 is the port number on the SERVER line in the 
license.lic file on the UNIX license server

joshua is the hostname of the UNIX license server

Conversely, the license server can be a Windows PC with a 
floating license locked to a LAN card or dongle hardware 
key and the UNIX computer can be set to point to it in the same 
way by using its host name or IP address.
Automating FLEXnet License Manager Startup
You can automate the FLEXnet startup so that lmgrd is 
started automatically each time the license server machine is 
rebooted by adding the following three lines for a startup 
routine to the appropriate rc file for your operating system:
/iccap/licenses/bin/lmgrd -c /iccap/licenses/license.lic >
/iccap/licenses/flex.log &
echo "Starting Agilent EEsof FLEXnet license daemon......"
/usr/bin/sleep 5
NOTE Be sure to change all references to /iccap to the actual path of your 
Agilent EEsof software installation directory.
Following are instructions for the supported operating systems:

1 Change to the appropriate directory:
/etc/rc.d/init.d (Linux)
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/etc/rc3.d (Solaris)

2 Create a file in this directory named Sagileesofd.
NOTE The S is capitalized. All other letters are in lower-case.
 

3 Place the FLEXnet startup routine (shown above) into this 
file.

4 Set the permissions for this file as follows:
chmod 755 Sagileesofd
chown root Sagileesofd
chgrp sys Sagileesofd

5 For Linux license servers, create the following soft links:
ln -s /etc/rc.d/init.d/Sagileesofd rc3.d/S99Sagileesofd
ln -s /etc/rc.d/init.d/Sagileesofd rc4.d/S99Sagileesofd
ln -s /etc/rc.d/init.d/Sagileesofd rc5.d/S99Sagileesofd
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Use the following information to accommodate any special 
licensing needs you may have. For details on using FLEXnet, 
refer to the Macrovision website at:

http://www.macrovision.com/support/by_catagory/Software
_Licensing.shtml
Using FLEXnet Options
An options file enables the license administrator to control 
the security parameters of FLEXnet. Specifically the license 
administrator can:

• Allow the use of features based on user, hostname or 
display name.

• Deny the user of features based on user, hostname or 
display name.

• Reserve licenses based on user, hostname or display 
name.

• Control the amount of information logged about license 
usage.

Creating an Options File

Use the desired options listed below to create the options 
file using any text editor. Ideally, you should keep the 
options file in the same directory as your license.lic file. 
Also, add the pathname to the options file in the license.lic 
file as the fourth field on the VENDOR line for agileesofd as 
shown in the following example. (Remember to use the 
backslash ('\') character if the file contains wrapped lines.)
VENDOR agileesofd /iccap2008/licenses/vendors/agileesofd \
/iccap2008/licenses/agileesofd.opt

You can include comments in your options file by starting 
each comment with a pound sign '#'. Everything in the 
options file is case-sensitive. Be sure that user names and 
feature names, for example, are entered correctly. The 
available options are:
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• EXCLUDE
Deny a user access to a feature.

• EXCLUDEALL
Deny a user access to all feature served by this vendor 
daemon.

• GROUP
Define a group of users for use with any options.

• INCLUDE
Allow a user to use a feature.

• INCLUDEALL
Allow a user to use all features served by this vendor 
daemon.

• NOLOG
Turn off logging certain items.

• REPORTLOG
Specify that a logfile be written suitable for use by the 
FLEXadmin End-User Administration Tool.

• RESERVE
Reserve licenses for an individual user or groups of users.

Use the following steps to create and use an options file. 
Details about each step located in “Installing Licenses” on 
page 93:

1 Create an options file with your required options.

2 Modify your license.lic file so that the VENDOR or 
DAEMON line points to this option file as shown in this 
example:
VENDOR agileesofd /iccap2008/licenses/vendors/agileesofd \
/iccap2008/licenses/agileesofd.opt

3 Start up your license server (lmgrd) that is pointing to 
your license file. You must stop it first if it is running. It’s 
important that a message is displayed or recorded in the 
FLEXnet log verifying the license manager is using the 
options file. 

4 Set AGILEESOFD_LICENSE_FILE to point to your license 
server.

5 Run IC-CAP.
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If you have been running FLEXnet and receive updated 
codewords from Agilent EEsof, you can add the new licenses 
to the FLEXnet environment as follows:

1 Replace the existing license.lic files on the license servers 
and clients with the new license.lic file.

2 On the primary server, run lmutil lmreread. This 
causes the lmgrd on the primary server to re-read the 
license.lic file and update all of the other lmgrd processes 
on the network.

3 After you have done this, you can run lmutil lmstat 
-a to verify that the license servers have received the 
new license information. 

If this does not work, you may need to stop all of the lmgrd 
processes on your network and then restart them as 
described in the section “Installing Licenses” on page 93. 
 Merging Multiple Vendor Licenses
When you are running FLEXnet-licensed products from 
multiple vendors, you have three ways to prevent licensing 
conflicts during installation:

• Multiple license server nodes; each running one lmgrd 
and one license file 

• One license server node running one lmgrd and one 
license file 

• One license server node running multiple lmgrds and 
multiple license files 

Each lmgrd can only read a single license file. With the first 
option you will have more license servers to monitor. With 
the third option you have only one server but multiple 
lmgrds to administer. 

Your product's license file(s) define the license server(s) by 
hostname and hostid in the SERVER line(s) in the license 
file. 
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• If the license files for two or more products contain 
identical hostids on the SERVER line(s), then these files 
can be combined. 

• If the license files for two products contain different 
hostids on a SERVER line, then the license servers for 
those products will be running on different nodes and the 
license files cannot be combined.

If you have two or more products whose license servers run 
on the same node (as specified by the SERVER lines in the 
license files), you may be able to combine the license files 
into a single license file. 

• If the SERVER lines in those files have identical hostids, 
then you can combine the files into a single file. 

• If the SERVER lines have different hostids, then you must 
keep the license files separate. 

More precisely, you can combine two license files under the 
following conditions:

• The number of SERVER lines in each file is the same.

• The hostid field of each SERVER line in one file exactly 
matches the hostid field of each SERVER line in the other 
file. 

Some possible reasons license files may not be compatible 
are: 

• License files are set up to run on different server nodes, 
so hostids are different. 

• One file is set up for single server (has only one SERVER 
line), the other is set up for redundant servers (has 
multiple SERVER lines).

• One vendor uses a custom hostid algorithm, so the hostids 
on the SERVER lines are different even though the files 
are for the same machine. 

If your license files are compatible as described above, then 
you can combine license files and run a single lmgrd, as 
described in “Combining License Files from Multiple Vendors” 
on page 110. If the license files are not compatible, then you 
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must keep the license files separate and run separate copies of 
lmgrd for each license file, as described in the section, “Using 
Separate License Files on the Same Server Node” on page 111.
NOTE There is virtually no performance or system-load penalty for running 
separate lmgrd processes.
Combining License Files from Multiple Vendors

If your license files are compatible, you can combine them 
using any text editor. To combine license files, merge all of 
the compatible license files into one file, then edit out the 
extra SERVER lines so that only one set of SERVER lines 
remains. Write out this data, and you have your combined 
license file. 

If you combine license files from multiple vendors, it is a 
good idea to keep a copy of the combined license file in 
each vendor's default license file location. This way, your 
users can avoid having to set AGILEESOFD_LICENSE_FILE, 
because each package finds its license information in the 
default place. On UNIX, you can do this with a symbolic link 
from each default location to the location of the combined 
license file.

FLEXnet Version Component Compatibility

When you combine license files for two different 
FLEXnet-licensed products, the products may not use the 
same version of FLEXnet. FLEXnet is designed to handle 
this situation. There are two basic compatibility rules for 
FLEXnet:

• A newer lmgrd can be used with an older vendor 
daemon, but a newer vendor daemon might not work 
properly with an older lmgrd. 

• A newer vendor daemon (or lmgrd) can be used with an 
older client program, but a newer client program might 
not work properly with an older vendor daemon. 
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From these two compatibility rules come the simple rules for 
selecting which version of administration tools to use: 

• Always use the newest version of lmgrd and the newest 
version of each vendor daemon. 

• Use the newest FLEXnet utilities. 

For specific application programs, you can use either the 
new or the old version (with the assumption that the vendor 
daemon for that application is at least as new as the 
application).

Using Separate License Files on the Same Server Node

You must run a separate copy of lmgrd for each license file. 
When you run multiple copies of lmgrd, there are two 
details to remember:

• The port number on the SERVER line of each license file 
must be unique. You can use a standard text editor to 
change the port number in each license file so that they 
are all different. 

• You must make sure that you are using a compatible 
version of lmgrd when you start it up for a particular 
license file. This can be done by using an explicit path to 
lmgrd. 

When running client programs (such as a licensed 
application), you can set the AGILEESOFD_LICENSE_FILE 
environment variable to point to multiple license files. For 
example, you may have a license file from vendor ABC and a 
license file from vendor XYZ with incompatible servers. You 
can place the license file from vendor ABC into:

/user/flexnet/abc.lic

and the license file from vendor XYZ into:
/user/flexnet/xyz.lic

then set the AGILEESOFD_LICENSE_FILE environment 
variable to point to both of them. The syntax is as follows:

AGILEESOFD_LICENSE_FILE=27000@server1;27000@server2;27000
@server3

Note that each path is separated with a semi-colon.
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AGILEESOFD_LICENSE_FILE can point to only one license 
file for FLEXnet v1.x applications.
Redundant License Servers
You can set up a redundant or backup license server(s), in 
case a primary server is unavailable. If your license.lic file 
has the maximum number of SERVER lines (three), you have 
a redundant license server configuration. The license setup 
is identical to a single SERVER configuration, with the 
exception that no licenses will be available until a majority 
of the license servers are running. That is, if you have three 
SERVER lines, at least two must be up and running before 
any licenses will be available for checkout. Be sure that the 
FLEXnet software is loaded and running on each server.
 

Controlling License Path Settings

NOTE If you have more than one SERVER line in the license.lic file, you must 
start lmgrd on all the SERVER machines to enable the licenses.
The lmutil utility provides the lmpath function which allows 
direct control over FLEXnet license path settings. You can 
use lmpath to add to, override, or get the current license 
path set in the registry. This enables you to change or view 
path settings without locating individual settings in the 
Windows registry on the PC or in the FLEXnet registry 
(.flexlmrc) on UNIX.

The lmutil utility is located in $ICCAP_ROOT/licenses/bin. 
This location must be in your PATH, or use the following 
command before running the utility:

cd $ICCAP_ROOT/licenses/bin

The usage for this function is:
lmutil lmpath {-status | -add | -override} {vendor_name |
all} license_path_list

where

-status displays the current license path settings.
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-add appends license_path_list to the front of the current 
license-path settings or creates the list of license-path 
settings, if it doesn’t exist, initializing it to 
license_path_list. Duplicates are discarded.

-override overrides the existing list of license-path 
settings with the contents of license_path_list. If 
license_path_list is the null string, "", the specified list is 
deleted. For example:
lmutil lmpath -override agileesofd ""

Deletes the value of AGILEESOFD_LICENSE_FILE from 
the registry.
lmutil lmpath -override vendor2 ""

Deletes the value of VENDOR2_LICENSE_FILE from the 
registry.
lmutil lmpath -override all ""

Deletes the value of LM_LICENSE_FILE from the registry.

vendor is a string naming a particular vendor daemon 
name. Affects the value of vendor_LICENSE_FILE. For 
example, use agileesofd to affect 
AGILEESOFD_LICENSE_FILE.

all refers to all vendor daemons. Affects the value of only 
LM_LICENSE_FILE. 

license_path_list is the new path setting(s). On UNIX, this is 
a colon-separated list, and on Windows it is a 
semi-colon-separated list. If license_path_list is the null 
string, "", then the list is deleted for the specified vendor. 
Though you can enter specific license file names, you gain 
flexibility by entering only a path without a file name. 
This will include all *.lic files in the same location.
NOTE Environment variable settings (set in your shell) always override these 
registry settings.
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Checking the Status

Before you change license path settings, Agilent recommends 
that you display the current settings. To display the settings, 
enter the following commands:

lmutil lmpath -status

The following example status listing is from UNIX and is 
similar to a Windows listing:
 

lmpath - Copyright (C) 1989-2004 Macrovision Corporation. All rights 
reserved.
Known Vendors:
_____________
agileesofd: /iccap2006icenses/license.lic:/iccap2008/licenses/license.lic
_____________
Other Vendors:
______________
/usr/local/flexlm/licenses/license.lic

NOTE Where a path is set to a directory, each of the *.lic files are listed 
separately.
Changing License Path Settings

When adding or overriding path settings, lmpath sets the 
FLEXnet entry in the Windows registry on the PC, or 
changes the file $HOME/.flexlmrc on UNIX. Here are examples 
of how license settings may appear in each registry:

UNIX:
AGILEESOFD_LICENSE_FILE = /iccap2002/licenses:/iccap2008/licenses

Windows:

Registry location:
My Computer\HKEY_LOCAL_MACHINE\Software\Agilent\ICCAP_2008

Registry license path setting:
AGILEESOFD_LICENSE_FILE REG_SZ C:\ICCAP_2008\licenses

To change license path settings, enter the appropriate 
command in a Command Prompt on Windows, or a terminal 
window on UNIX. You can adapt the following examples which 
change path settings for AGILEESOFD_LICENSE_FILE:
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• To add path settings on UNIX:
lmutil lmpath -add agileesofd 
<new_lic_path1>:<new_lic_path2>

• To add path settings on Windows:
lmutil lmpath -add agileesofd C:\<new_lic_path1>;C:\
<new_lic_path2>

• To replace the current path settings on UNIX:
lmutil lmpath -override agileesofd <new_lic_path>

• To replace the current path settings on Windows:
lmutil lmpath -override agileesofd C:\<new_lic_path>
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This section discusses how to manage the licenses for 
multiple versions of IC-CAP.
Backward Compatibility of Codewords
The following table lists previous IC-CAP versions with 
details of their license management. The compatibility of 
codewords with the various IC-CAP versions is discussed 
below.

  
 

Release Name License 
File 
Version

Daemon 
Name

FLEX Version License Environment 
Variable

Default License File 
Location

IC-CAP 2001 6.0 agileesof FLEXlm 7.2h LM_LICENSE_FILE $ICCAP_ROOT/licenses/

IC-CAP 2002 6.1 agileesof FLEXlm 7.2h LM_LICENSE_FILE

IC-CAP 2004 2.3 agileesofd FLEXlm 8.2a CRO AGILEESOFD_LICENSE_FILE

IC-CAP 2006 2.3.5 agileesofd FLEXnet 10.1.3 CRO AGILEESOFD_LICENSE_FILE

IC-CAP 2008 2.7 agileesofd FLEXnet 11.4.1 AGILEESOFD_LICENSE_FILE
The following table shows the codeword compatibility 
between various IC-CAP releases. Note that codeword 
compatibility also depends on the whether the codeword was 
available in that release.
Codewords From 
This Release

Will Work With This Release

IC-CAP 2008 IC-CAP 2006 IC-CAP 2004 IC-CAP 2002 IC-CAP 2001

IC-CAP 2008 X X

IC-CAP 2006 X X

IC-CAP 2004 X

IC-CAP 2002 X X
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Combining IC-CAP 2008 Codewords with Other Agilent EEsof EDA 
Codewords

IC-CAP 2001 X X

Codewords From 
This Release

Will Work With This Release

IC-CAP 2008 IC-CAP 2006 IC-CAP 2004 IC-CAP 2002 IC-CAP 2001
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For IC-CAP 2008, the vendor daemon agileesofd is used. If you 
want to serve IC-CAP 2008 licenses and earlier from the same 
server, you need to have the latest version of lmgrd, v11.4.1, and 
one or more DAEMON lines in your license file, depending on 
which versions you want to support. The IC-CAP daemon names 
available are:

agileesofd - for IC-CAP 2004/2006/2008

agileesof - for IC-CAP 2002/2001

For example, the license file would include:
SERVER hpnmems 77a588a7 1700

VENDOR agileesofd /iccap2008/licenses/vendors/agileesofd
VENDOR agileesof /iccap2002/licenses/vendors/agileesof

The INCREMENT lines for the different products would then 
be added to the file.
NOTE If combining codewords for IC-CAP 2001 or IC-CAP 2002 
and ADS 2002 or ADS 2002C, use the agileesof daemon 
included with ADS since it is a newer version than the one 
included with IC-CAP.
Here is how you might build a license file that contains 
IC-CAP 2008, ADS 2003C, ADS 2002C, and IC-CAP 2001 
codewords. The name and extension of the license file are 
arbitrary (i.e., license.dat, license.lic or iccaplicenses.txt). By 
default, all IC-CAP versions up to and including IC-CAP 
2001 look for a file named license.dat and IC-CAP 2002, 
IC-CAP 2004, and IC-CAP 2008 look for a file named license.lic. 
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You can use one of these names, or some other name you prefer. 
Whatever name you choose to use, make sure you set the 
environment variables to point to your license file.

Supported environment variables are: 

• AGILEESOFD_LICENSE_FILE for IC-CAP 2004/2006/2008 

• LM_LICENSE_FILE for IC-CAP 2002 and IC-CAP 2001

For example, if the combined codeword file is named 
iccaplicenses.txt, then:

• IC-CAP 2008 will use:

AGILEESOFD_LICENSE_FILE=/licenses/iccaplicenses.txt

• IC-CAP 2002 and IC-CAP 2001 will use:

LM_LICENSE_FILE=/licenses/iccaplicenses.txt

IC-CAP uses a certain search order to look for the 
environment variable:

• IC-CAP 2004/2006/2008 will first look for the environment 
variable named AGILEESOFD_LICENSE_FILE. If 
AGILEESOFD_LICENSE_FILE and LM_LICENSE_FILE are 
both defined, IC-CAP 2004/2006/2008 will use 
AGILEESOFD_LICENSE_FILE and ignore 
LM_LICENSE_FILE. If AGILEESOFD_LICENSE_FILE is not 
defined, then IC-CAP 2004/2006/2008 will default to 
LM_LICENSE_FILE.

• All previous IC-CAP versions, up to and including 
IC-CAP 2002 will use LM_LICENSE_FILE.
NOTE Even though IC-CAP 2008 will default to LM_LICENSE_FILE if that is the 
only environment variable that exists, it is recommended that you use the 
AGILEESOFD_LICENSE_FILE.
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ne 80FB214D 1700
 

SERVER solaro
VENDOR agileesof /hfs/d1/local/licenses/agileesof
VENDOR agileesofd /hfs/d1/local/licenses/agileesofd
#
# ADS 2001 codewords
#
INCREMENT Adapt_comp hpeesofd 1.5 03-nov-2002 5 EC7A98E3FB4AC8771142 \
        VENDOR_STRING=s=80FB214D
INCREMENT Ad_da_appkit hpeesofd 1.5 03-nov-2002 5 \
        1CCA189368AF358196C4 VENDOR_STRING=s=80FB214D
INCREMENT Ampsa_appkit hpeesofd 1.5 03-nov-2002 5 \
        0CBAB813D8101E34EB55 VENDOR_STRING=s=80FB214D
INCREMENT Analog_lib hpeesofd 1.5 03-nov-2002 5 9CEA88930822C5CF81AC \
        VENDOR_STRING=s=80FB214D
INCREMENT Tx_appkit hpeesofd 1.5 03-nov-2002 5 6C0A5873869F9624DFF5 \
        VENDOR_STRING=s=80FB214D
INCREMENT User_defined_model hpeesofd 1.5 03-nov-2002 5 \
        2CAAE8E326E3D9DD888B VENDOR_STRING=s=80FB214D
INCREMENT Verilog_code_gen hpeesofd 1.5 03-nov-2002 5 \
        FCAA489350CD03768D44 VENDOR_STRING=s=80FB214D
INCREMENT Vhdl_code_gen hpeesofd 1.5 03-nov-2002 5 \
        FC4A58B306109B640C5C VENDOR_STRING=s=80FB214D
INCREMENT Wcdma3g_des_lib hpeesofd 1.5 03-nov-2002 5 \
        DC7AA89389009E4B61BF VENDOR_STRING=s=80FB214D
INCREMENT Wcdma_des_lib hpeesofd 1.5 03-nov-2002 5 \
        7C0A38F308FA2C30CE3D VENDOR_STRING=s=80FB214D
INCREMENT Wlan_des_lib hpeesofd 1.5 03-nov-2002 5 \
        4C8A6893E259E6C86399 VENDOR_STRING=s=80FB214D
#
# IC-CAP 2001 codewords
#
INCREMENT a_si_tft agileesof 6.0 29-oct-2001 1 D0A4535DE290 \
        VENDOR_STRING=s=80FB214D
INCREMENT ac_driver agileesof 6.0 29-oct-2001 1 1A9EE36873A0 \
        VENDOR_STRING=s=80FB214D
INCREMENT analysis agileesof 6.0 29-oct-2001 1 025C2B939BD5 \
        VENDOR_STRING=s=80FB214D
INCREMENT curtice_statz_fet agileesof 6.0 29-oct-2001 1 7D88F11FEE4B \
        VENDOR_STRING=s=80FB214D
INCREMENT dc_driver agileesof 6.0 29-oct-2001 1 65C14D4C7948 \
        VENDOR_STRING=s=80FB214D
INCREMENT gummel_poon_bjt agileesof 6.0 29-oct-2001 1 8FB9632C0555 \
        VENDOR_STRING=s=80FB214D
INCREMENT ucb_bsim3 agileesof 6.0 29-oct-2001 1 BEDFA8C2810F \
        VENDOR_STRING=s=80FB214D
INCREMENT ucb_bsim4 agileesof 6.0 29-oct-2001 1 D454A8AB830D \
        VENDOR_STRING=s=80FB214D
INCREMENT ucb_mos2_mos3 agileesof 6.0 29-oct-2001 1 D9768F388827 \
        VENDOR_STRING=s=80FB214D
INCREMENT vbic_bjt agileesof 6.0 29-oct-2001 1 3DE6FB45CD8C \
        VENDOR_STRING=s=80FB214D
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#
# ADS2005A codewords
#
INCREMENT ads_datadisplay agileesofd 2.35 08-nov-2005 1 \

VENDOR_STRING="81AAAAAA : DXNLFPQ WZBCLQ2 AUJXJ2E IEKCKLI \
WFYQNVM DNJU1YM LHYKAQC OM" HOSTID=81aaaaaa START=11-may-2005 \
SIGN="0169 4457 1B00 5266 852D 7813 5FB6 F38F 941A 1D0F E300 \
F868 5245 2627 CF7B 03B9 037F 9F0F 6BAE 32F6 321C"

INCREMENT ads_layout agileesofd 2.35 08-nov-2005 1 \
VENDOR_STRING="81AAAAAA : KSGSOTJ D1JYAXW BOCLRMW 2YNB2HN \
GFVU2LG FQ1AQPJ UGW" HOSTID=81aaaaaa START=11-may-2005 \
SIGN="0115 CEDE 58A8 A734 FF5C 8AC8 A3AC DAE6 FD7E E9D2 C002 \
EB4B 0FF8 884C 61BE 84D7 AB0F A3E2 47EA EC43 A5E6"

INCREMENT ads_schematic agileesofd 2.35 08-nov-2005 1 \
VENDOR_STRING="81AAAAAA : NNWCSOI WSVFWVZ JOXDHFS NRMW2YN \
BHAHUW2 JMAJGIJ OEYHM1W ST" HOSTID=81aaaaaa START=11-may-2005 \
SIGN="03E6 6359 6509 5297 45E2 6EB6 DBAF B148 04BF DE83 C502 \
E872 86AA 522C 9257 369B BE71 A3F5 4FDE 16E2 F13F"

INCREMENT mdl_multilayer agileesofd 2.35 08-nov-2005 1 \
VENDOR_STRING="81AAAAAA : TS1OKRT EIQGAUY DLYSXUY LUTGOHK \
ULCKL2R XYPNPHN EFKNVMD NGCWP" HOSTID=81aaaaaa \
START=11-may-2005 SIGN="0333 DFD8 FD38 B049 9935 34CD A24B \
91DF 8BE5 3E17 3D03 3CAB 88C2 4239 D021 526B 45F1 E539 FA55 \

#
# IC-CAP 2008 Codewords
#
INCREMENT dev_bjt_gp_ee agileesofd 2.7 19-mar-2008 2 \

VENDOR_STRING="00008XXOOXXO : SYAQRDS F1AQCOM CNEXTBD FBLCHLO \
WYGJYZD WTFLQZD WQYQBHI EFZ" START=20-oct-2005 SIGN="023E 6EC8 \
0EAD 7537 5072 CA30 C5F9 3DAE 73BC 3168 D601 453A F3BE F758 \
ACE2 4576 CE88 FB0E 8663 C8EE 918B"

INCREMENT dev_bsim3 agileesofd 2.7 19-mar-2008 2 \
VENDOR_STRING="00008XXOOXXO : WVRFWQG PJEL1QG AUYILYS XUYGJCY \
L2WEYGO LSRXYBG PHEUL" START=20-oct-2005 FFA0 0BD3 8206 B191 \
E658 F333 440F 8D03 17F3 D6CB A53B C176 1CDF 5A91 6BB4 28D0 \
1386 E211"

INCREMENT dev_bsim4 agileesofd 2.7 19-mar-2008 2 \
VENDOR_STRING="00008XXOOXXO : WZJDCYM NBWJ1YM YMQGRFW XSUCLYD \
GXDWYGJ YZDWTY2 NMAJ" START=20-oct-2005 SIGN="012B FF53 9F9D \
3ED9 47A5 8744 E57E 4B07 9FC0 B0F1 7D03 A125 35B2 3FF2 9C97 \
ABE9 66E5 D12D 5EDD 718D EC6A"

INCREMENT dev_bsimsoi agileesofd 2.7 19-mar-2008 2 \
VENDOR_STRING="00008XXOOXXO : KKEYWEH VXGIJRV WDYLNT2 ACFUBHA \
VU2JOEN WFMJOPB SOKTNCH 1O" START=20-oct-2005 SIGN="001A C20B \
3EDE 88BE 0FAF D892 4310 DCE0 9D76 0830 B100 71FA E487 CD4F \
EEDE E019 2E71 F2D5 D338 A728 D607"
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Using the Agilent License Information Tool
IC-CAP Installation and Customizati
The Agilent License Information Tool is available to check 
your environment variable settings, display your license.lic 
file, and show your license and server status.

To run this tool from the IC-CAP Main window, choose Help 
> License Information. To run it from the terminal window, 
type $ICCAP_ROOT/bin/aglmtool and press Enter to 
display the following window:
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Using IC-CAP on UNIX Systems

Running IC-CAP 124

IC-CAP Does Not Start 138

Starting IC-CAP in Verbose Mode (Debug Mode) 139

Common Licensing Problems 140

Installation and Configuration Issues 145

Differences in Measurement Between Sun and HP Systems 148

IC-CAP Disappears and no Message is Displayed 150

To get you started using IC-CAP on a UNIX system, this chapter 
includes some basics along with useful tips for resolving 
problems that might occur after you have installed IC-CAP.
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Running IC-CAP
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Your FLEXnet license file must be properly configured and 
installed before you can run IC-CAP. To set up your license file, 
follow the instructions in Chapter 5, “Setting up Licenses on 
UNIX Systems.”

To run IC-CAP, open a terminal window and enter iccap

Choose Help > Topics and Index > User’s Guide for help on 
getting started with IC-CAP.
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Printing and plotting from IC-CAP on UNIX is accomplished 
by establishing the desired print setup and then choosing 
File > Print. For a complete description of IC-CAP printing, 
refer to Chapter 9, “Printing and Plotting” in the IC-CAP 
User’s Guide. 

The Print Setup and related dialog boxes enable you to:

• Select a printer/plotter other than the default

• Install additional printers or plotters

• Set the print resolution (dpi)

• Scale the output

When you select a printer/plotter, you can also change the 
following default printer/plotter-specific options:

• Page Size

• Source (Paper Tray)

• Duplexing (Double-sided)

• Orientation (Portrait or Landscape)

• Color (Black and White or Color)

When you choose File > Print, you can select from the 
following additional options:

• Choose to send output to a printer/plotter or print to file

• Scale the output to fit to the page

• Select a file format (if printing to file)

• Specify the number of copies

Your print setup is saved in $HOME/.Xprinterdefaults. If you 
do not have a local copy of this file, or the file .Xpdefaults 
(from a previous release), the default file is read from the 
$HPEESOF_DIR/xprinter directory. When you change your 
print setup, the changes are saved (as new defaults) to 
$HOME/.Xprinterdefaults. 
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NOTE If you do have a file .Xpdefaults (from a previous release), the settings of 
this file are copied to the new filename to serve as the starting point for 
your print setup. Both files are valid, depending on which release of 
IC-CAP you are using. The old file is maintained for running an earlier 
version of IC-CAP, but the new file is used when you run IC-CAP 2006 (or 
later).
126
The Print Setup dialog box enables you to setup and manage 
your printer options. To access the Print Setup dialog box,

1 Choose File > Print Setup. The Print Setup dialog box 
appears.
 

For detailed information on using the Print Setup dialog box, 
refer to the following table.
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Table 4 Using the Print Setup Dialog box

Option Description

Printer Use this section of the Print Setup dialog box 
to define and manage your printers.

Name: Select a printer from the Name drop-down list. 
If the printer you want to use is not available in 
the list, click the Printer Management button. 
For more information, refer to “Managing 
Printers” on page 129.

Printer Management If you want to add, replace, or remove a 
printer, click the Printer Management button 
to access the Printer Management dialog box. 
For more information, refer to “Managing 
Printers” on page 129.

Model Info: This section displays the selected printer 
model information.

Resolution (dpi): This option enables you to set the print quality 
(resolution) in dots per inch (dpi).

Scale Factor (%): This option enables you to set a scaling factor 
that defines the percentage of normal size by 
which to enlarge or reduce the document on 
the page. Default is 100%.
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Paper Use this section of the Print Setup dialog box 
to define the paper settings.

Size: Use the Size drop-down menu to select the 
paper size. Default is Letter. 

Note that paper sizes can vary depending on 
the paper manufacturer. If you own a printer 
that provides a specific paper size that you are 
not familiar with, consult your printer manual 
for information on the paper size options 
available. The more common American paper 
sizes are listed below in inches (Width vs. 
Height).

Letter = 8.50" (W) x 11.00" (H)
Executive = 7.25" (W) x 10.55" (H)
Legal = 8.50" (W) x 14.00" (H)
Tabloid = 17.00" (W) x 11.00" (H)
Ledger = 11.00" (W) x 17.00" (H)

Consult the International Organization for 
Standardization (ISO) for standard A through 
D-sizes as well as RA and SRA-sizes.

Source: Use the Source drop-down menu to select the 
tray that has the paper you want to use. 
Default is the Upper tray.

Duplexing: The Duplexing drop-down menu enables you 
to print on both sides of the paper. The options 
available are:
- None - No duplexing, the document will only 
print on one side of the paper.
- Flip on Short Edge - This option prints on both 
sides of each sheet and flips the page along 
the short edge of the paper.
- Flip on Long Edge - This option prints on both 
sides of each sheet of paper and flips the page 
along the long edge of the paper.
The default Duplexing option is None.

Table 4 Using the Print Setup Dialog box (continued)

Option Description
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Orientation Use this section of the Print Setup dialog box 
to define the orientation of your printed page.

Portrait Click this option if you want your output 
printed in portrait orientation mode. Portrait is 
taller than it is wide when you view the text 
right-side up. Default is activated.

Landscape Click this option if you want your output 
printed in landscape orientation mode. 
Landscape is wider than it is tall when you 
view the text right-side up. Default is 
deactivated.

Color Use this section of the Print Setup dialog box 
to define your color settings.

Black and White Click this option if you want your output in 
black and white. Default is activated unless 
the system detects support for color printer. If 
this is the case, the system will default to the 
color option.

Color Click this option if you want your output in 
color. Default is deactivated unless the system 
detects support for color printer. If this is the 
case, the system will default to the color 
option.

Table 4 Using the Print Setup Dialog box (continued)

Option Description
Managing Printers
The Printer Management dialog box enables you to manage 
an individual printer or group of printers. To access the 
Printer Management dialog box,

1 Choose File > Print Setup. The Print Setup dialog box 
appears.

2 Click the Printer Management button in the Print Setup 
dialog box. The Printer Management dialog box appears.
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For detailed information on using the Printer Management 
dialog box, refer to the following table.

Table 5 Using the Printer Management Dialog Box

Options Description

Installed Printers The Installed Printers field displays a list of all currently 
installed printers.

Printer Drivers Use the Printer Drivers drop-down list to select a printer 
driver.

Defined Ports Use the Defined Ports drop-down menu to select a defined 
port.

Ports To define a new printer port and/or replace or remove an 
existing printer port, click the Ports button to access the 
Ports dialog box. For more information on the Ports dialog 
box, refer to “Defining Printer Ports” on page 131.
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Add To install a new printer, select a printer driver and a defined 
port, then click the Add button. The new printer appears in 
the Installed Printers list.

Replace To replace an existing printer, click the printer you want to 
replace in the Installed Printers list. Then select a new 
printer driver and a new defined port. Click the Replace 
button to replace the printer. The new printer appears in 
place of the old printer in the Installed Printers list.

Remove To remove an existing printer or group of printers, click the 
printer(s) you want to remove in the Installed Printers list 
and then click the remove button. 
A confirmation dialog box appears asking if you really want 
to remove the printer. Click OK to confirm or Cancel to abort 
the removal process. If you click OK, the printer(s) no longer 
appears in the Installed Printers list.

Help Click the Help button to access the online context sensitive 
help.

Close Click the Close button to dismiss the Printer Management 
dialog box and accept the changes. Settings will be saved 
upon exit.

Table 5 Using the Printer Management Dialog Box (continued)

Options Description
Defining Printer Ports
The Ports dialog box enables you to define new printer ports 
and/or replace or remove existing printer ports. To access 
the Ports dialog box,

1 Choose File > Print Setup. The Print Setup dialog box 
appears.

2 Click the Printer Management button. The Printer 
Management dialog box appears.

3 Click the Ports button. The Ports dialog box appears.
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For detailed information on using the Ports dialog box, refer 
to the following table.

Table 6 Using the Ports Dialog Box

Option Description

Ports The Ports field displays a list of ports. Port names can be any 
names you choose with the exception of FILE: which is a 
reserved port name.

Edit Port The Edit Port field is used to enter a new port. After you have 
entered the port definition, click the Add/Replace button.

Add/Replace Click the Add/Replace button to update the Ports list with 
contents of Edit Port field.

Remove If you want to remove a port from the Ports list, click the port 
name in the Ports list to activate the Remove button. Click the 
Remove button to remove the selected port.

Import from 
Spooler

Click the Import from Spooler button to generate a list of ports 
(based on your printcap file).

Note that the third party utility that provides this feature does 
not guarantee it to operate on the current supported platforms.

Help Click the Help button to access the online context sensitive help.
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Close Click the Close button to dismiss the Ports dialog box and accept 
the changes. Settings will be saved upon exit.

Table 6 Using the Ports Dialog Box (continued)

Option Description
Printing to a Printer, Plotter, or File
The Print dialog box enables you to output your information 
to a supported printer, plotter, or specified file. To access 
the Print dialog box,

1 Choose File > Print. The Print dialog box appears.
 

For detailed information on using the Print dialog box, refer 
to the following table.

Table 7 Using the Print Dialog Box

Option Description

Printer The Printer options in the Print dialog box 
enable you to define a printer and the output 
characteristics.
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Name: Select a printer from the Name drop-down list. 
If the printer you want to use is not available in 
the list, click the Cancel button and access the 
Print Setup dialog box.

Model Info: This section displays the printer model 
information.

Status: This section displays information on the printer 
status. If the printer is ready to print, the Status 
will display Ready.

Properties Click the Properties button to view or set 
additional options used in the Print Setup dialog 
box. For more information, refer to “Setting Up 
a Printer” on page 126.

Fit to Page Activate the Fit to Page option if you want your 
output to be automatically scaled to fit on the 
page.

Print to File Activate the Fit to Page option if you want your 
output to be directed to a file. 

When this option is selected, the Number of 
Copies feature is deactivated and the Print to 
File feature is activated. 

When this option is deactivated, the Number of 
Copies feature is activated and the Print to File 
feature is deactivated.

Copies This section is used to set the number of copies 
to print.

Number of Copies Use this feature to specify the number of copies 
to print. If Print to File is selected, this feature is 
deactivated.

Print to File This section is used to define the type of file 
you want to send your output to.

Table 7 Using the Print Dialog Box (continued)

Option Description
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File Format: Use this feature to specify the file format to 
save your output to.

After you have selected your file format, click 
OK in the Print dialog box. A Print to File dialog 
box will appear enabling you to define the path 
and name of the file. For more information on 
the Print to File dialog box, refer to “Printing to 
a File” on page 136.

If the Print to File radio button is deselected, 
this feature is deactivated.

OK Click the OK button to accept the settings and 
send your output to the selected printer or file, 
depending on how you have set your options. 
Settings will be saved upon exit.

Cancel Click the Cancel button to dismiss the Print 
dialog box. Settings will not be saved upon exit.

Help Click the Help button to access the online 
context sensitive help.

Table 7 Using the Print Dialog Box (continued)

Option Description
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The Print to File dialog box enables you to define a 
destination path and file name and then output your 
information to the specified file. To use the Print to File 
dialog box,

1 Choose File > Print. The Print dialog box appears.
 

2 Select the Print to File option in the Printer section of 
the Print dialog box. Notice that when you select the 
Print to File option, the Print to File section is activated 
enabling you to select a file format.

3 Use the File Format drop-down list to select the desired 
file format. Options include JPEG, GIF, PDF, Bitmap, and 
HP-GL/2.

4 Click OK in the Print dialog box. The Print to File dialog 
box appears.
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5 Enter the file name for your output in the Selection field.

6 Click the OK button to output the file.
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It is possible to install programs or options for which you 
have not purchased licenses. Although the icons and features 
will appear in the software, you cannot access the 
applications without a license. Contact your Agilent EEsof 
sales representative to obtain additional licenses.

If your IC-CAP applications will not start:

• Make sure all of your licensing requirements are correctly 
set up, as explained in Chapter 5, “Setting up Licenses on 
UNIX Systems.”

• Using a text editor open and review the install.log file in 
your installation folder to see if there are any apparent 
problems with the installation structure. (You can re-run 
Setup if necessary to re-install.)

• Try using the Agilent License Information Tool, which is 
available to check your environment variable settings, 
display your license.lic file, and show your license and 
server status. Refer to “Using the Agilent License Information 
Tool” on page 121.

If you cannot find the problem, run IC-CAP in verbose 
(debug) mode and contact Technical Support to help 
pinpoint the problem.
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IC-CAP 2008 can be started in verbose (debug) mode to display 
more information about what is occurring as IC-CAP runs. This 
extra information can be very useful to debug a problem with 
IC-CAP both at startup and in general operation. In verbose 
mode, IC-CAP writes log files that can be used by Agilent EEsof 
EDA Technical Support to help track down any problems.

To start IC-CAP in verbose mode, do the following:

1 Open a UNIX terminal window.

2 Type iccap_verbose.

This will start IC-CAP. You will see some messages 
indicating the location of two log files. Note the location of 
these files as indicated in the messages. The filenames are 
as follows:

iccap_daemon.log

iccap_verbose.log
NOTE If iccap_verbose is not found, you may need to set the HPEESOF_DIR and 
PATH environment variables.
Run IC-CAP until the problem you are trying to debug 
occurs, then take a look at the iccap_daemon.log and 
iccap_verbose.log files for errors.

If you can’t locate the trouble based on the contents of the 
log files, please contact Agilent EEsof EDA Technical 
Support. You will want to e-mail the log files to the support 
engineer you work with.
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Following are solutions to common problems that occur 
regarding the FLEXnet licensing setup for IC-CAP. 

For details on using FLEXnet and lmtools, refer to the 
Macrovision website at:

http://www.macrovision.com/support/by_catagory/Software
_Licensing.shtml
Where to Begin
If you are having trouble getting FLEXnet working, the best 
place to begin troubleshooting is the flex.log file. The 
flex.log file is typically located in $ICCAP_ROOT/licenses. 
Read the flex.log file and look for error or warning 
messages.

If no relevant errors or warnings are noted in the flex.log 
file, start IC-CAP in debug mode by setting the following 
environment variable in a UNIX window, then start IC-CAP:

C Shell (/bin/csh)
setenv HPEESOF_DEBUG_MODE all

Bourne/Korn Shell (/bin/sh, /bin/ksh)
HPEESOF_DEBUG_MODE=all
export HPEESOF_DEBUG_MODE

Look for errors or warnings in the shell where you started 
IC-CAP.
Common Errors and Solutions
Following are possible solutions to certain license-related 
error messages that occur.
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Inconsistent Encryption Code

This error occurs when the information on the INCREMENT 
lines in the license.lic file is corrupt or incorrectly 
formatted. Check the license.lic file for the following:

1 Make sure that each line of the license.lic file is a single 
continuous line with each field separated by a single 
space.

2 If there are backslash characters ('\') line wrapping the 
lines, make sure that the backslash character is the 
absolute last character on its line. Even a space after the 
'\' will cause a problem.

3 Try removing the backslash characters and joining the 
INCREMENT lines, so that each INCREMENT line is a 
single continuous line with no line wrap.

4 If the license.lic file was transferred from DOS to UNIX, 
make sure to remove the control M's (^M) at the end of 
all the lines in the license.lic file. If spaces are added to 
the end of each line to eliminate the ^M's, the spaces 
must also be removed. The spaces turn out to be just as 
disruptive as the ^M's. The best way to remove the ^M's is 
using the vi editor and the following substitution 
command:
:1,$ s/.$//g

5 Make sure that none of the original SERVER line hostid 
information has been changed. Make sure that none of the 
SERVER lines have been eliminated.

Invalid Host or Unable to Determine Machine ID

This can be caused by one of the following:

1 Make sure that the information on the SERVER line(s) in 
license.lic is correct.

2 If the licenses are node-locked, and you attempt to run 
IC-CAP on a machine other than the machine the licenses 
are node-locked to, you will get a license error indicating 
invalid host. To check if this is the case, look at the 
$ICCAP_ROOT/licenses/license.lic file and check the 
INCREMENT lines. If each INCREMENT line ends in a 
machine hostid, then the licenses are node-locked to the 
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machine whose id is shown. You can, however, export the 
display from the node-locked machine to another display.

3 If you are on an HP workstation, check the permissions of 
the /dev/lan0 file. This file must have read and write 
permissions for all:
chmod 777 /dev/lan0

The FLEXnet lmgrd and agileesof vendor daemons use 
this file and must be able to read and write to this 
device. 

Invalid System Clock Time

FLEXnet detects when systems have had their dates set 
more than 24 hours back, and prevents users from using 
expired licenses by setting the clock back. It works by 
looking for any files in “/” or “/etc” that have a date more 
than 24 hours in the future.

Use the command ls -lat in “/” and “/etc” to find the 
offending file(s). The date of the offending file(s) can be 
corrected by using the touch command:

touch <filename>

If the file is a link, the link must be removed and then 
recreated. If the link itself is dated ok, check the date of the 
actual file or directory it points to. The pointed to file must 
also have a valid date.

A Feature is Not Enabled

FLEXnet codewords have both enable and expiration dates. 
If the codeword enable date is in the future with respect to 
the current machine date, then this error will occur.

First check the date on the computer. If it is not today's 
date, correct it. On UNIX systems, the date can be set using 
the date command:

date mmddhhmm[yy]

For example, to set the date to 23 Sept, 2002 at 13:30, the 
command would be:

date 0923133002
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If this still does not correct the problem, or if the date is 
correct, then request new codewords with an enable date set 
to today's date.

Cannot Connect to License Server

If you see a flex.log file with the following errors:

(lmgrd) Started agileesofd

(agileesofd) Vendor daemon can't talk to lmgrd (cannot 
connect to

license server) port 1700

(lmgrd) Vendor daemon died with status 241

(lmgrd) Since this is an unknown status, lmgrd will

(lmgrd) attempt to re-start the vendor daemon.

(lmgrd) REStarted agileesofd (internet tcp_port xxxx)

Make sure that the lmgrd and agileesofd daemon are the 
correct version (version 8.2h or higher). The lmgrd daemon 
should have the same or higher version number as 
agileesofd. You can check version numbers as follows:

cd $ICCAP_ROOT/licenses
./bin/lmgrd -v
./vendors/agileesofd -v

Make sure that the workstation is connected to a network or 
that the network connector on the workstation is properly 
terminated. FLEXnet will not work if the network connection 
is down or if the network services are not starting properly. 
Check all physical network connections to make sure that 
they are okay and look for errors during machine boot up. 
On HP700 workstations, look at the /etc/rc.log file for errors.

Make sure that the agileesofd is being started successfully by 
lmgrd. If agileesofd cannot be started from the path 
specified on the VENDOR line in the license.lic file, this 
error will occur. Also make sure that the agileesofd file has 
execute permissions:

cd $ICCAP_ROOT/licenses/vendors
chmod 755 agileesofd
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Address Already in Use

The tcp port number specified on the SERVER line in the 
license.lic file is in use by another process. Try the 
following: Kill any stranded lmgrd processes. Remove the 
/usr/tmp/.flexnet/lmgrd.xxxx file that contains the tcp port 
you want to use. You can remove the entire /usr/tmp/flexnet 
directory if you are the only one using lmgrd on this 
machine, then restart lmgrd. If you still have a problem, try 
using a different tcp port number on the SERVER line in 
license.lic and then restart lmgrd.

Here is an example of properly configured SERVER lines:
SERVER joshua 2072EFE45 1705
SERVER isaiah 20472A3D3 1705
SERVER jonah 2052C6416 1705
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Following are helpful hints for installation and configuration 
problems that may occur.
Viewing Installation Files
If you wish to see a list all of the IC-CAP files that have 
been installed, they are identified in the text-only fileset file, 
which can be accessed from the directory: $ICCAP_ROOT/etc.
Recovery of Temporary Files
 

If IC-CAP is abruptly terminated (by power failure, kill 
command, system shutdown and so on), temporary files may 
be left in one of the following locations:

• /var/tmp

• directory specified if $TMPDIR file is defined

• /tmp for Linux regardless of $TMPDIR or $ICCAP_TMP

If work is lost during a crash, files beginning with an IC... 
filename might contain macro and transform PEL code that 
can be recovered. If they exist, these files will appear in the 
appropriate tmp directory.

Purge these files, but only when IC-CAP is not running. 
Avoid removing any files that are currently in use by other 
applications running on the CPU or cluster. IC-CAP 
temporary files appear in blocks that are all created at 
approximately the same time, and share the last four or five 
digits of their names. 
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If you are having memory problems when running IC-CAP 
on a SUN system, try the following:

1 Create a new kernel.

2 Increase the value of the maxuers variable to 32 from 16.

This variable affects many other system variables, as it 
figures in the equations for calculating their value. It is 
recommended to limit the value of this variable to about 
128, as a larger number tends to become counter-productive.
Checking XNLSPATH Variable
If you are having difficulty starting or running IC-CAP, 
check to see if the environment variable XNLSPATH is 
specified in your .cshrc (C-shell) or .profile (Bourne or Korn 
shell) startup file in your home directory. This variable 
should not be set. If it is, cancel the setting and restart 
IC-CAP.
 

Specifying Start and End Address of Instrument Searches
The INST_START_ADDR system variable specifies the start 
address for instrument searching during Rebuild (active list). 
This value should be an integer between 0 and 31, 
inclusively. When there is a printer, plotter, or prober on the 
same GPIB with measurement instruments, set 
INST_START_ADDR greater than any one of those 
non-instruments to avoid the identification process. Default 
is 0. You may need to change some addresses. The objective 
is that IC-CAP should not attempt to communicate with any 
printer, prober, or plotter on the GPIB bus during the 
rebuild.

The INST_END_ADDR system variable specifies the ending 
address for instrument searching during Rebuild (active list). 
This value should be greater than the INST_START_ADDR 
value and less than 31.
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The following table shows some important installation 
differences between usage of Linux vs. SUN systems.

Table 8 HP vs. SUN Installations

Item Linux Systems SUN Systems

Default interface file hpib or gpib1 (depending 
on interface)

/dev/gpib0

Card identity Select code Board number

Default card address 21 0

Time out value Continuous Discrete

Bus hang Breakable Rely on time out

HP-GL plotter Supported Supported

Character set (plotter 
only)

USASCII only USASCII only

Window Manager KDE or Gnome Motif or OpenWindows 
or CDE
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Differences in measurement between HP and SUN systems 
include the interface file, the select code, the bus lock and 
the timeout value.
Interface File 
Because the Sun SPARCstation does not have an Agilent 
GPIB interface, a GPIB interface from National Instruments 
is used. This interface plugs into one SBus (or PCI 
depending on your machine’s bus architecture) slot of the 
workstation and is named /dev/gpib0 to serve as a GPIB 
board. National Instruments has provided a library to 
control this interface either as a raw GPIB file or an 
addressed device. Refer to the NI488-M Software Manual for 
more information.
 Select Code 
IC-CAP treats the GPIB interface as a raw GPIB file. This 
requires a select code on HP to be replaced with a board 
number on Sun calculated from the minor number of the 
device file. National supports up to 2 interfaces per system. 
So the board number is either 1 (first board) or 2 (second 
board). When this number is larger than 2, it is an 
addressed device which is not suitable for IC-CAP operation. 
The installation script of the National interface creates 
/dev/gpib0 as a GPIB board file. The default GPIB address of 
the interface is 0 on Sun and 21 on HP. This should not 
cause any problems. 
Bus Lock 
Because of the limited capability of the National card, I-O 
Lock and I-O Unlock do not function. This means users 
must avoid concurrent accesses to the GPIB board used by 
IC-CAP. 
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The available timeout values are: 10ms, 30ms, 100ms, 300ms, 
1sec, 3sec, 10sec, 30sec, 100sec, 300sec, 1000sec, and None 
(0sec). Any value that falls between two discrete values 
becomes the larger one. A timeout value larger than 1000sec 
turns off the timeout mechanism. 
 

NOTE An infinite timeout value (0sec) is not recommended for this GPIB 
interface because even a KILL signal cannot terminate the bus hang 
condition.
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If IC-CAP disappears and does not print any message to the 
terminal window, it may be because you have issued the 
UNIX command stty tostop (either in the terminal window 
or from within a start-up file such as .cshrc, .profile, etc.). 
When you do this, certain IC-CAP error messages may not 
be displayed.

To prevent this from happening, issue the command stty 
-tostop prior to launching IC-CAP.
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Agilent EEsof worldwide technical support is available 
Monday through Friday. The toll-free North America hotline 
is open 6:00 am to 5:00 pm PT. Throughout Europe, the 
localized Online Technical Support Centers are open 8:30 am 
to 5:30 pm, local time; throughout Asia, the localized 
Customer Response Centers are open 9:00 am to 6:00 pm, 
local time.

The e-mail addresses for the various regions are listed 
below. However, for both the regional e-mail addresses and 
local telephone numbers for more than 25 countries, please 
refer to the Agilent EEsof Web site at

http://www.agilent.com/find/eesof/

North America 

Phone: 1 800 47 EEsof (473-3763) · Fax: 818-879-6465

e-mail: eesof_support@agilent.com 

Europe: e-mail: eesof-europe_support@agilent.com 

Japan: e-mail: eesof-japan_support@agilent.com

Korea: e-mail: eesof_korea@agilent.com

Asia: e-mail: eesof-asia_support@agilent.com
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IC-CAP uses a number of configuration files. The files contain 
definitions for configuration variables and environment 
variables.
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On UNIX, environment variables are usually initialized in a 
shell start-up file such as .cshrc (C-shell) or .profile 
(Bourne-shell) in your home directory. 

On Windows, the required environment variables are 
maintained in the Windows Registry. To set optional 
environment variables, open System Properties (choose start > 
Control Panel > System) then select the Advanced tab and choose 
Environment Variables.

Table 9 describes the most common environment variables used 
by IC-CAP.
 

NOTE The environment variable name $HPEESOF_DIR should point to an 
installation of ADS. However, IC-CAP is built on some of the same 
technology, so IC-CAP remembers your $HPEESOF_DIR environment 
variable as $ADS_DIR at startup, and temporarily reassigns 
HPEESOF_DIR=$ICCAP_ROOT during the run of IC-CAP in the IC-CAP 
process space only. Thus references to $HPEESOF_DIR in configuration 
files under $ICCAP_ROOT/config are equivalent to references to 
$ICCAP_ROOT when IC-CAP is running.
bles
Table 9 System Environment Varia

Name Default Value Description

ICCAP_ROOT /usr/local/iccap2008 The location where the IC-CAP software 
was installed (also called the root 
location). This variable is used 
extensively throughout IC-CAP. The 
default value is also set in the registry 
during installation. Therefore, the default 
value normally should not be changed.

LM_LICENSE_FILE $ICCAP_ROOT/licenses/license.lic Specifies the location of the FLEXnet 
security license files. Use the 
AGILEESOFD_LICENSE_FILE variable 
instead of this variable.
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ICCAP_OPEN_DIR None Specifies the directory where the 
user-compiled code library resides. For 
more information, refer to “Creating C 
Language Functions in IC-CAP" in the 
IC-CAP User’s Guide.

AGILEESOFD_LICENSE_FILE $ICCAP_ROOT/licenses/license.lic Specify the location of the FLEXnet 
security license files, overriding the 
LM_LICENSE_FILE variable. 

ICCAP_TMP None The location where temporary IC-CAP 
files are located. If ICCAP_TMP is not set, 
temporary files will be stored in the 
directory specified by $TMPDIR on UNIX 
or %TMP% on Windows. If $TMPDIR or 
%TMP% are not defined, files will be 
stored at /var/tmp for UNIX or the 
directory specified by %TEMP% on 
Windows. If ICCAP_TMP, TMP, or TEMP 
do not reference a valid temporary 
directory on Windows, IC-CAP will not 
run.

ADS_DIR None The location of the ADS installation to 
use when performing hpeesofsim 
simulations. Set when using Windows.

HPEESOF_DIR None The location of the ADS installation to 
use when performing hpeesofsim 
simulations. Set when using Linux or 
Solaris.

Table 9 System Environment Variables

Name Default Value Description
IC-CAP Installation and Customizati
Setting Environment Variables

To set an Environment Variable:

• Choose Start > Settings > Control Panel > System > Advanced > 
Environment Variables and enter the variable name and value.

For example:

Variable Value
ICCAP_OPEN_DIR c:\WIN\System32;
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The default values of the configuration variables should get you 
up and running, but they can be customized to better reflect 
your work environment. By default, the program searches for 
these configuration files in the following order, and uses the 
first one found:

• Your current working directory

Define configuration variables here that apply only to your 
current working directory.

• Your personal directory = $HOME/hpeesof/config

Define configuration variables here that apply to your user 
directory.

Note: On the PC, %HOME% represents the path you specified 
as the Home Folder during installation ( by default, C:\users\
default)

• The IC-CAP installation directory $ICCAP_ROOT/config

Define the default installed configuration variables here that 
apply to all projects of all users. Configuration variables 
should not be customized here.

Each of the individual IC-CAP tools has its own configuration 
file. The supplied configuration files can be found in the 
directory $ICCAP_ROOT/config (where $ICCAP_ROOT 
represents the complete installation path). The filenames for 
each of the tools are shown in Table 10.

Table 10 Configuration Filenames

Product/Tool Filename

Layered A.P.I. eeapi.cfg

RGB Colors eecolorRGB.cfg

TXT Colors eecolorTXT.cfg

Legacy support of HPGL and B/W PostScript eehcopy.cfg

Colors iccolor.cfg
IC-CAP Installation and Customization Guide



Customizing the IC-CAP Environment 7

IC-CAP Installation and Customizati

 

Fill Patterns icfill.cfg

Globally used paths hpeesof.cfg

Browser hpeesofbrowser.cfg

Data Sets hpeesofdss.cfg

Online help system hpeesofhelp.cfg

IC-CAP iccap.cfg

Table 10 Configuration Filenames (continued)

Product/Tool Filename
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Configuration variables are defined using standard assignment 
syntax:

<variable>=<value>

where variable is the configuration variable name and value is 
the string that is assigned to the variable. This value can be a 
directory, search path, numeric value, or other value defined by 
the program. For example, the location of the preferences could 
be set by:

PREFERENCES_DIR={$ICCAP_ROOT}/de/defaults

where $ICCAP_ROOT is an environment variable representing 
the complete installation path.

Note the following details about file format, illustrated in the 
accompanying example:

• Any line starting with # is a comment line and is ignored

• Blank lines are ignored

• Blank spaces to the left or right of the equal sign are ignored

• Empty assignments are acceptable (as shown by env_var_2)

Example

#
# This is a sample configuration file 
#
env_var_1 = first_value 
env_var_1a = value-1a 
#
env_var_2 = 
env_var_3 = 17
env_var_4 = $SYSTEM/%HOME/ex4 
env_var_4a = {$ICCAP_ROOT}/de/defaults/{%env_var_1a}.ex4a

References to environment variables $name and IC-CAP 
configuration variables %name can appear in any order; they 
are resolved inside each IC-CAP program. A reference to an 
environment variable or configuration variable name may be 
enclosed in braces { } when their use is not followed by a 
punctuation character. The braces are not included in an 
expanded value.
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IC-CAP configuration variables are identified by a 
case-insensitive string of 1 to 31 alphanumeric characters (an 
underscore is allowed). Variables that are longer than 31 
characters are automatically truncated when the configuration 
file is read. When a variable is set from a configuration file, the 
line

<variable>=<value>

is parsed and variable is set to the value.

A configuration variable can contain a reference. A reference 
may be enclosed in braces and the text is preceded by either 
a $ or % (see Table 11). For example,

PREFERENCES_DIR={$ICCAP_ROOT}/de/defaults

assigns the string $ICCAP_ROOT/de/defaults to the 
configuration variable PREFERENCES_DIR, and $ICCAP_ROOT 
is defined in a start-up file.

Most IC-CAP configuration variables are assigned a single value. 
This text can represent a number, string, file, or path as in the 
following examples.

STATUS_DISP = 0 
EESTATUS_LOG_FILE = Off 
HPEESOF_KEY = $ICCAP_ROOT/licenses/hpeesof.key 
PREFERENCES_DIR={$ICCAP_ROOT}/de/defaults

Table 11 IC-CAP Configuration Variables

Configuration variable Description

$name The configuration variable is replaced by the text string 
assigned to name in the environment.

%name The configuration variable is replaced by the text string 
assigned to name in the IC-CAP configuration file. 

Certain IC-CAP variables have a pre-defined meaning 
in a given program. All of the special IC-CAP 
configuration variables that are recognized are given in 
the shipped {$ICCAP_ROOT}/config/<app-name>.cfg 
file.
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Note that when the file is outside of a project configuration, it is 
necessary to include the full path with the filename to ensure 
that the file is found.

Some IC-CAP configuration variables accept a path assignment. 
A path is a list of one or more directories, where each directory 
is separated by a colon.

variable=directory:directory: ....

These variables can represent search paths or load paths, 
depending on the variable and the program. Ordering of the list 
is significant. When treated as a search path, the list is only 
scanned until the item needed is found. For loading, the entire 
list is sequentially examined with the last directory usually 
taking precedence.

The documentation for each specific variable indicates the type 
of value allowed. Some variables may have a limited type, such 
as a range of numbers or list of specific strings.
Configuration Variable Expansion
Configuration variable expansion refers to the process of 
replacing all references and variables that make up the 
configuration variable with their text equivalents until the 
complete value of the configuration variable is known. (There 
are no limits to the levels of referencing you can use.) Note that 
this expansion is done internally by the program; the file that 
contains the variable assignments is not modified.

For example, assume that the system environment variable 
ICCAP_ROOT is set to opt/iccap/mysite and the following two 
lines exist in a configuration file.

MY_LIB    = {$ICCAP_ROOT}/lib/iccap
ICCAP_LIB = {%MY_LIB}/rf1

After expansion within IC-CAP:
MY_LIB = /opt/iccap/mysite/lib/iccap
ICCAP_LIB = /opt/iccap/mysite/lib/iccap/rf1

As in the system environment, you may redefine and add your 
own IC-CAP variables in any IC-CAP configuration files to help 
manage system- and user-specific configurations. 
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Each configuration is distinguished by its name. Each named 
configuration contains all of the variables needed for describing 
that particular setup. At the topmost level is the configuration 
file named hpeesof.cfg, which is associated with all IC-CAP 
programs. Other named configurations are associated with 
specific programs.

Each named configuration is determined by the location and 
content of any related configuration files. For example, the 
complete iccap configuration could consist of:

• The file iccap.cfg, located in the install directory 
$ICCAP_ROOT/config

• An edited copy of this same file, located in the customized 
site directory $ICCAP_ROOT/custom/config

• An edited copy of this same file located under your home 
directory $HOME/hpeesof/config directory

• An edited copy of this same file located in a particular 
working directory

As noted earlier, configurations in the user directory take 
precedence over the installation directory, and configurations 
in the working directory take precedence over the user 
directory. This is because the search order for configuration 
information is: working directory, user directory, and 
installation directory.

Note that variables in each successive file override any 
previously set value. You can even put two lines in the same 
configuration that assign values to the same variable, as in:

MY_VAR1 = entrya 
MY_VAR1 = entryb

When expanded, MY_VAR1 will always have the value of entryb.

The following table shows a list of named configurations used in 
the programs.
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Table 12 Named Configurations

Activity Configuration

Graphical User Interface customization iccap, hpeesof

Plot graphics hpeesof

Hardcopy customization hpeesof

Online Help hpeesofhelp

Colors iccolor
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Special Variables
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There are two configuration files that have a different syntax 
than the others: iccolor and icfill. Note that the naming 
convention and loading of system-wide, home directory, and 
work directory configurations still apply. Only the internal file 
format differs.
Color Definitions, iccolor.cfg
 

The various windows comprising the IC-CAP design 
environment, as well as plotters, use the colors defined in the 
iccolor configuration. By default, these colors are read from 
{$ICCAP_ROOT}/config/iccolor.cfg, but can be overridden at 
the installation, user, or working directory level (any of which 
can have an iccolor file).

The iccolor file format differs from the variable=value syntax. 
Each line contains these major fields:

• RGB color values

• Color name

• Plotter pen number

The syntax for each line is as follows:
<Red #> <Green #> <Blue #> : <Color name> : <Pen number>

The following example illustrates the format of a typical color 
definition file:

R G B X11 color name Plotter pen number

0 0 0 : black 1

255 0 0 : red : 2

0 255 0 : green : 3

0 0 255 : blue : 4

255 255 255 : white : 5

128 64 0 : : 6

salmon : 7
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Colors are described in the first and/or second fields of this file. 
You can enter three RGB color values (in the range 0-255) in the 
first field and/or you can enter the X color name from the RGB 
color database (found in /usr/lib/X11/rgb.txt for Motif or 
/usr/openwin/lib/rgb.txt for Sun’s Open Windows) in the 
second field. If both are entered, the RGB values take 
precedence, and the color name is ignored. 

The last field specifies which pen number to use for hard-copy 
output when performing HPGL plotting. An entry in this field is 
required and pen numbers may be recycled and repeated.

By default, the current implementation uses shared server 
colors from the RGB color database and uses no privately 
allocated color cells for X Window displays. This is done to 
simplify the color specification and to promote sharing of 
colors. Sharing of color cells can only happen if two clients 
allocate read-only color cells with the same X color name or 
RGB values.
 NOTE On UNIX, we strongly recommend that you only use the names given in 
the RGB color database instead of explicit RGB values; on the PC, only 
RGB values are supported.
Because of differences in screen hardware, the same RGB 
values may generate different colors on different hardware. By 
using names from the color database, you are more likely to get 
colors close to the ones requested across different hardware 
platforms. 

It is also important to note that values corresponding to color 
names are not fixed. Therefore, they may not be exactly the 
same across all platforms or correspond to an exact RGB value.
NOTE Some platforms have limited color resources and some platforms may use 
non-shared colors, resulting in color exhaustion problems. When IC-CAP 
programs run into these types of color problems, the solution is to reduce 
the number of requested colors until color conflicts stop occurring. As an 
example, truncating the list of colors in iccolor.cfg to 64 colors may be a 
good start.
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An example iccolor configuration file is shown:
# 
============================================================
# IC-CAP Color Definition File:
# 
============================================================
#   R   G   B  :  Color Name  :  Plotter Pen #
#  --- --- ---    ----------     -------------
#   0   0   0  :    black     :       1
#  255  0   0  :    red       :       2
#   0  255  0  :    greeen    :       3
#   0   0  255 :    blue      :       4
#  255 255  0  :    yellow    :       5
#  255  0  255 :    magenta   :       6
#   0  255 255 :    cyan      :       7
#  255 255 255 :    white     :       8
#
# For Unix X Windows systems either RGB values or standard    
# X Color Names, or both, may be specified for color entries. 
# For Windows only RGB values are supported.
# Note, if both RGB and Color Name values are specified,
# the RGB  values take precedence.
# 
============================================================
#
  0   0   0 :black : 0 # First always black
255   0   0 :red : 1 # First trace color
255 255   0 :yellow : 2 # Second trace color
  0 255   0 :green : 3 # Third trace color
  0 255 255 :cyan : 4 # Fourth trace color
  0   0 255 :blue : 5 # Fifth trace color
255   0 255 :magenta : 6 # Sixth trace color
192 192 192 :gray : 7 # Eighth trace color
255 255 255 :white : 8 # Eighth always white
NOTE Although not recommended, you can change the default colors in the 
iccolor.cfg file. The iccolor example above shows the lines that set the 
color for trace 1 through 6 and for trace 8. Not shown is that line 88 sets 
the trace 7 color, line 32 sets the Y2 trace color, and line 54 sets the Plot 
Optimizer region box color. For an example, see the iccap.cfg.adv file 
located in $ICCAP_ROOT/iccap/lib/cust_advanced.
If the IC-CAP configuration file cannot be found or the hpeesof 
configuration does not contain an HPEESOF_COLOR variable 
(which determines the location of the IC-CAP color definition 
file), a set of ten basic default server colors are automatically 
loaded as follows:

1 = black  4 = green 7 = magenta 10 = medium blue

2 = red 5 = cyan 8 = gray

3 = yellow 6 = blue 9 = white 
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Besides colors, plotters also use the fill patterns defined by the 
icfill configuration. By default, these patterns are read from 
{$ICCAP_ROOT}/config/icfill.cfg, but can be overwritten at the 
working directory or user directory (any of which can have an 
icfill file).

The icfill file format differs from the variable=value syntax. 
Each line contains two major fields.

• Path and filename of the fill pattern

• HPGL/2-pattern-specification

The syntax for each line is as follows:
<Bitmap_file_location> : <Fill type> <Line spacing> <Angle>

where

• Fill type—is the pattern inside an object’s border

• Line spacing—is the distance between the hatched lines in 
plotter units (where a plotter unit is typically 1/72-inch).

• Angle—is the angle of hatch lines in the fill pattern, 
expressed in degrees (for fill type 3 or 4 only).

The following example illustrates the format of a typical fill 
pattern definition file:

Fill patterns use standard X-bitmap files that can be easily 
created with the X bitmap utility. The first field specifies the 
path to the X-bitmap file, which is used for pattern fills, while 
the remaining fields are the HPGL/2 fill pattern specification. 

/fill/pat/path/pat1.pattern  :  3  50  15
/fill/pat/path/pat2.pattern  :  3  50  30
/fill/pat/path/pat3.pattern  :  4  60  45
/fill/pat/path/pat4.pattern  :  4  60  90

Angle

Line Spacing

Fill Type
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Fill type description Fill type number

Solid bidirectional 1

Solid unidirectional 2

Hatched 3

Cross hatched 4
NOTE Solid bidirectional fill is faster than solid unidirectional fill, but is not 
supported by all plotters.
 

An icfill configuration file is shown in the following example:
#===========================================================
#EEsof Fill Pattern Definition File:
#===========================================================
#X Bitmap Filename  : Type  Spacing  Angle  (Hardcopy output)
#-----------------    --------------------
#path/pattern_file1 :  3      70      15
#path/pattern_file2 :  4      50      45
#path/pattern_file3 :  4      45      90 
#===========================================================
#0
{$HPEESOF_DIR}/de/fill_patterns/pat1.pattern : 3 25 15 
{$HPEESOF_DIR}/de/fill_patterns/pat2.pattern : 3 25 30 
{$HPEESOF_DIR}/de/fill_patterns/pat3.pattern : 3 25 45
{$HPEESOF_DIR}/de/fill_patterns/pat4.pattern : 3 25 60
{$HPEESOF_DIR}/de/fill_patterns/pat5.pattern : 3 25 75
{$HPEESOF_DIR}/de/fill_patterns/pat6.pattern : 3 25 90
{$HPEESOF_DIR}/de/fill_patterns/pat7.pattern : 4 25 15
{$HPEESOF_DIR}/de/fill_patterns/pat8.pattern : 4 25 30

If the IC-CAP configuration file cannot be found or the hpeesof 
configuration does not contain an HPEESOF_FILL variable 
(which determines the location of the IC-CAP fill definition 
file), a single, unidirectional, solid fill pattern is automatically 
loaded.
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This section describes the configuration variables found in the 
IC-CAP configuration files.
Variables in the File iccap.cfg
This configuration file is used to define several of the directory 
paths used by IC-CAP, such as paths for examples and model 
libraries, as well as other program features. The file is located in 
$ICCAP_ROOT/config.

The following table shows variables that exist by default in the 
iccap.cfg file.

An additional set of variables for customizing advanced features 
exist in the file iccap.adv. These variables are described in 
Table 14 and can be added to your iccap.cfg file as needed. The 
iccap.adv file is located in 
$ICCAP_ROOT /iccap/lib/cust_advanced.

Table 13 Variables in the file iccap.cfg

Variable name, description, and example Value(s)

AEL_PATH
Example: 
AEL_PATH={$ICCAP_ROOT}/ael/iccap:{$ICCAP_ROOT}/ael/ic
stat:{$ICCAP_ROOT}/ael/api

Directory

BUILTINSIMPATH
Example: BUILTINSIMPATH={$ICCAP_ROOT}/bin

Directory

ICCAP_PC_UNIX_CMDS
This is the directory IC-CAP uses to find UNIX style commands on 
the PC.
Example: ICCAP_PC_UNIX_CMDS={$ICCAP_ROOT}/tools/bin

Directory

MARKER_FILE_NAME
Search path and filename for plot marker file.
Example: 
MARKER_FILE_NAME={$ICCAP_ROOT}/config/markers

Filename
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FONT_FILE_NAME
Search path and filename for plot font file.
Example: FONT_FILE_NAME={$ICCAP_ROOT}/config/usascii

Filename

ICCAP_EXAMPLE_DIRECTORY
Search path and directory for example files. Accessed by 
selecting File > Examples from the Main window.
Example: 
ICCAP_EXAMPLE_DIRECTORY={$ICCAP_ROOT}/examples

Directory

ICSTAT_EXAMPLE_DIRECTORY
Search path and directory for Statistics example files. Accessed 
by selecting File > Examples from the Statistics window
Example: ICSTAT_EXAMPLE_DIRECTORY= 
{$ICCAP_ROOT}/examples/icstat

Directory

ICCAP_MODEL_DIRECTORY
Search path and filename for model library files.
Example: 
ICCAP_MODEL_DIRECTORY=%ICCAP_EXAMPLE_DIRECTORY

Directory

USERSIMFILE
Search path and filename for user simulator files.
Example: 
USERSIMFILE={$ICCAP_ROOT}/iccap/lib/usersimulators

Filename

INSTRALIASFILE
Search path and filename for the instrument aliases file, 
instraliases
Example: 
INSTRALIASFILE={$ICCAP_ROOT}/iccap/lib/instraliases

Filename

ABOUT_FILE
Search path and filename for restricted rights and copyright file.
Example: ABOUT_FILE={$ICCAP_ROOT}/config/about.txt

Filename

TECH_SUPPORT_FILE
Search path and filename for technical support contact file.
Example: 
TECH_SUPPORT_FILE={$ICCAP_ROOT}/config/support.txt

Filename

Table 13 Variables in the file iccap.cfg (continued)

Variable name, description, and example Value(s)
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ICCAP_FUNCTION_BROWSE_DATA
Search path and filename for help text displayed in Function 
Browser.
Example: 
ICCAP_FUNCTION_BROWSE_DATA={$ICCAP_ROOT}/iccap/lib
/functions.hlp

Filename

PULSECFG
Search path and filename for pulse driver configuration.
Example: PULSECFG={$ICCAP_ROOT}/iccap/lib/hp85124.cfg

Filename

PULSECAL
Search path and filename for pulse driver calibration 
configuration.
Example: PULSECAL={$ICCAP_ROOT}/iccap/lib/hp85124.cal

Filename

ICCAP_WHATS_NEW_FILE
Search path and filename for what is new in IC-CAP file.
Example: 
ICCAP_WHATS_NEW_FILE={$ICCAP_ROOT}/config/new.txt

Filename

TCPTRANSEXE
Example: TCPTRANSEXE={$ICCAP_ROOT}/bin/tcptrans

Filename

ICCAP_IM_CONVERT
Example: ICCAP_IM_CONVERT= 
{$ICCAP_ROOT}/bin/ImageMagick/convert

Filename

ICSTATUS_EXECUTABLE
Example: 
ICSTATUS_EXECUTABLE={$ICCAP_ROOT}/bin/hpeesoficstatus

Filename

ICCAP_CPP_PATH
Search path and filename for CPP.
Example: ICCAP_CPP_PATH={$ICCAP_PLATFORM_DIR}/cpp

Filename

ICCAP_BUILTIN_GROUPS_TEXT
Search path and filename for creating built-in groups
Example: ICCAP_BUILTIN_GROUPS_TEXT=
{$ICCAP_ROOT}/config/builtin_groups.txt

Filename

Table 13 Variables in the file iccap.cfg (continued)

Variable name, description, and example Value(s)
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To use the variables listed in the following table, add them to 
the file iccap.cfg. For a graphical description of the color 
variables, see the figures following the table.

DRAW_PAGE_DEFAULT_MAGNIFICATION
Control default magnification setting for drawing areas. (Smaller 
number means larger text.)
Example: DRAW_PAGE_DEFAULT_MAGNIFICATION=1.8

Positive real 
number

DRAW_PAGE_DEFAULT_FONT
Control default font type for drawing area.
Example: DRAW_PAGE_DEFAULT_FONT=Arial For CAE

Font type

ICCAP_LICENSE_TIMEOUT
Controls time until acquired licenses are automatically released. 
Reusing a license during time period resets timer. Disabling the 
auto-release requires manual release of license, or exit IC-CAP.
Example: ICCAP_LICENSE_TIMEOUT=300 (Default)

Seconds

300 or higher
0 disables 
auto-release

API_DOUBLE_CLICKS_TIME_OUT
Milliseconds before second click must occur. (Larger number is 
slower duration.)
Example: API_DOUBLE_CLICKS_TIME_OUT=500

Milliseconds

ICCAP_NUM_RECENT_FILES
Controls the number of files the system remembers from history.
Example: ICCAP_NUM_RECENT_FILES=5 (Default)

Positive 
integer

ICCAP_MAX_RECENT_CHARS
Controls the width of the menu pick(s) for recent files.
Example: ICCAP_MAX_RECENT_CHARS=40 (Default)

Positive 
integer

ICCAP_MAX_VIS_TUNERS
Sets the maximum number of parameters visible in a tuner 
window. A scroll bar appears if the number of parameters exceed 
this number. 
Example: ICCAP_MAX_VIS_TUNERS=8 (Default)

Positive 
integer

ICCAP_CPP_ARGS
Extra argument to pass to cpp when performing simulations. This 
should rarely need to be reset.
Example: ICCAP_CPP_ARGS=-H32000

Arguments

Table 13 Variables in the file iccap.cfg (continued)

Variable name, description, and example Value(s)
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Table 14 Variables in file .iccap.adv

Variable name, description, and example Value(s)

ICCAP_ICON_SIZE
Size of toolbar icons.
Example: ICCAP_ICON_SIZE=LARGE

LARGE or SMALL

ICCAP_MAIN_PAGE_COLOR
Background color of Main window.
Example: ICCAP_MAIN_PAGE_COLOR=9

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_MEAS_PAGE_COLOR
Background color of Measurement window.
Example: ICCAP_MEAS_PAGE_COLOR=10

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_PLOT_PAGE_COLOR
Background color of Plots window.
Example: ICCAP_PLOT_PAGE_COLOR=11

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_ICON_BG_COLOR
Background color of model symbol icons.
Example: ICCAP_BG_COLOR=12

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_ICON_FG_COLOR
Foreground color of model symbol icons.
Example: ICCAP_ICON_FG_COLOR=16

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_ICON_EDIT_BG_COLOR
Background color of editable label of model 
symbol icons in Main window
Example: 
ICCAP_ICON_EDIT_BG_COLOR=29

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_ICON_EDIT_FG_COLOR
Foreground color of editable label of model 
symbol icons in Main window
Example: 
ICCAP_ICON_EDIT_FG_COLOR=30

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_ICON_EDIT_HI_COLOR
Highlight color of editable label of model 
symbol icons in Main window
Example: ICCAP_ICON_EDIT_HI_COLOR=31

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_INPUT_BG_COLOR
Background color of input tiles.
Example: ICCAP_INPUT_BG_COLOR=13

Range allowed (1 to the number 
of colors specified in eecolor.cfg)
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ICCAP_OUT_BG_COLOR
Background color of output tiles.
Example: ICCAP_OUT_BG_COLOR=14

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_PLOT_BG_COLOR
Background color of Plots window.
Example: ICCAP_PLOT_BG_COLOR=15

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_SELECT_COLOR
Color of highlight box that surrounds Model 
window icons when they are selected
Example: ICCAP_SELECT_COLOR=17

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_SELECT_COLOR
Color of highlight of selected input, output, 
and plot tiles
Example: ICCAP_TILE_SELECT_COLOR=18

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_BORDER_COLOR
Border color of input, output, and plot tiles
Example: ICCAP_TILE_BORDER_COLOR=19

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_TITLE_BG_COLOR
Background color of input, output, and plot 
tile labels
Example: 
ICCAP_TILE_TITLE_BG_COLOR=20

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_TITLE_FG_COLOR
Foreground color of input, output, and plot 
tile labels
Example: 
ICCAP_TILE_TITLE_FG_COLOR=21

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_TITLE_EDIT_BG_COLOR
Background color of input, output, and plot 
names
Example: ICCAP_TILE_EDIT_BG_COLOR=23

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_TITLE_EDIT_FG_COLOR
Foreground color of input, output, and plot 
names
Example: ICCAP_TILE_EDIT_FG_COLOR=22

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

Table 14 Variables in file .iccap.adv

Variable name, description, and example Value(s)
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ICCAP_TILE_TITLE_EDIT_HI_COLOR
Highlight color of the input, output, or plot 
names when highlighted for editing
Example: ICCAP_TILE_EDIT_HI_COLOR=24

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_LINE_FG_COLOR
Foreground color of text of individual line 
items of inputs, outputs, and plots
Example: ICCAP_TILE_LINE_FG_COLOR=25

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_LINE_EDIT_ FG_COLOR
Foreground color of associated text of line 
item
Example: ICCAP_TILE_LINE_EDIT_ 
FG_COLOR=26

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_LINE_EDIT_ BG_COLOR
Background color of associated text of line 
item
Example: ICCAP_TILE_LINE_EDIT_ 
BG_COLOR=27

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICCAP_TILE_LINE_EDIT_ HI_COLOR
Highlight color of associated text of line item
Example: ICCAP_TILE_LINE_EDIT_ 
HI_COLOR=28

Range allowed (1 to the number 
of colors specified in eecolor.cfg)

ICSTATUS_WINDOW_TO_TOP
Sets the default behavior of the Status 
window, where On means the Status 
window pops to the front of the screen 
anytime new messages are displayed in it, 
and Off means it does not pop forward 
automatically.
Example: ICSTATUS_WINDOW_TO_TOP=1

0=Off
1=On

Table 14 Variables in file .iccap.adv

Variable name, description, and example Value(s)
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BACKUP_FILES_WHEN_ASKED
Controls prompt for file backup when using 
File > Save As.
YES always creates backup of file without a 
prompt.
NO saves file without creating backup or 
prompting for backup.
ASK prompts to overwrite existing file, and 
create backup.
Example: 
BACKUP_FILES_WHEN_ASKED=ASK

YES, NO, or ASK

OVERWRITE_FILES_WHEN_ASKED
Controls prompt for overwriting files when 
saving.
YES always overwrites files without a 
prompt.
NO prevents overwrite of any file; you must 
save to a new name or remove existing file.
ASK prompts to overwrite existing file.
Example: 
OVERWRITE_FILES_WHEN_ASKED=ASK

YES, NO, or ASK

ICCAP_USER_FUNCTION_BROWSE_DATA 
Search path and filename for user defined 
help text displayed in Function Browser in 
addition to the functions.hlp file. The default 
is blank. Separate multiple filenames with a 
semicolon (;) on Windows and a colon (:) on 
UNIX.
Example: 
ICCAP_FUNCTION_BROWSE_DATA=
{$ICCAP_OPEN_DIR}/user_funcs.hlp:
{$HOME}/myfuncs.hlp

Filename(s)

Table 14 Variables in file .iccap.adv

Variable name, description, and example Value(s)
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ICCAP_MEAS_PAGE_COLOR

ICCAP_INPUT_BG_COLOR

ICCAP_OUT_BG_COLOR

ICCAP_TILE_TITLE_EDIT_FG_COLOR

ICCAP_TILE_LINE_EDIT_HI_COLOR

ICCAP_TILE_LINE_FG_COLOR

ICCAP_TILE_TITLE_BG_COLOR

ICCAP_TILE_TITLE_FG_COLOR
(text color)

(text color)

(text color)

ICCAP_TILE_BORDER_COLOR
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ICCAP_PLOT_PAGE_COLOR

ICCAP_TILE_TITLE_EDIT_HI_COLOR
ICCAP_TILE_TITLE_EDIT_BG_COLOR

ICCAP_PLOT_BG_COLOR

ICCAP_TILE_LINE_EDIT_FG_COLOR

ICCAP_TILE_LINE_EDIT_BG_COLOR

ICCAP_TILE_SELECT_COLOR

(text color)

ICCAP_MAIN_PAGE_COLOR

ICCAP_ICON_FG_COLOR
ICCAP_ICON_BG_COLOR

ICCAP_ICON_EDIT_BG_COLOR

ICCAP_ICON_EDIT_FG_COLOR

ICCAP_ICON_EDIT_HI_COLOR

ICCAP_ICON_SELECT_COLOR

(text color)
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This section lists additional variables that can be added to the 
configuration file iccap.cfg to customize the default size and 
location of many IC-CAP program windows. One or more of the 
following specifications can be added to the variables shown in 
Table 15.

• _X, the X-coordinate (left-right) for the default position of a 
window (0 is the left edge of the screen)

• _Y, the Y-coordinate (up-down) for the default position of a 
window (0 is the top edge of the screen)

• _WIDTH, the default, in pixels, for the width of a window

• _HEIGHT, the default, in pixels, for the height of a window

• _MIN_WIDTH, the minimum width, in pixels, to which you 
can shrink the window

• _MIN_HEIGHT, the minimum height, in pixels, to which you 
can shrink the window

Example:
HARDWARE_WINDOW_X=75
HARDWARE_WINDOW_Y=5
HARDWARE_WINDOW_WIDTH=950
HARDWARE_WINDOW_HEIGHT=700
HARDWARE_WINDOW_MIN_WIDTH=690
HARDWARE_WINDOW_MIN_HEIGHT=540

Table 15 Default Window Size and Location Variables

Variable Description

HARDWARE_WINDOW The Hardware Manager Window

MODEL_WINDOW The window displaying any currently open 
model file

STATUS_WINDOW The window that displays status, warning, 
and error messages

SIMDEB_WINDOW Simulation Debugger Window

SYSVAR_WINDOW System Variables Window

PLOT_OPTIMIZER Plot Optimizer Window
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DETACH_SETUP_WINDOW The detachable window that appears when 
you select a setup from the DUT/Setup pane 
and click Detach

DETACH_MACRO_WINDOW The detachable window that appears when 
you select a macro from the Select Macro 
list box (in the Macros folder) and click 
Detach

DETACH_VARIABLE_WINDOW The detachable window that appears when 
you select Tools > System Variables and 
click Detach

DETACH_PARAM_WINDOW The detachable window that appears when 
you click Detach in the Model Parameters 
folder

ICSTAT_MAIN_WINDOW The main Statistics window (Statistical 
Analysis)

ICSTAT_ANALYSIS_WINDOW The Statistics window that appears when 
you choose Analysis Data from the Analysis 
menu

ICSTAT_SUMMARY_WINDOW The Statistics window that displays 
statistical data

ICSTAT_BOUNDARY_WINDOW The Statistics window in which boundary 
analysis data is displayed

ICSTAT_RESIDUAL_WINDOW The Statistics window in which residual 
correlation data is displayed

ICSTAT_FACTOR_WINDOW The Statistics window that displays a 
summary table showing the dominant 
parameter for each factor and its value, as 
well as the factor group data (Analysis > 
Factor/Parameter Groups).

Table 15 Default Window Size and Location Variables (continued)

Variable Description
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This configuration file is used by the Help Server to locate the 
Online Help documents. The file is located in 
$ICCAP_ROOT/config.

Table 16 Variables in the file hpeesofhelp.cfg

Variable, description, and example Value(s)

TOPLEVEL_DOC
Top level index document location.
Example: TOPLEVEL_DOC = $ICCAP_ROOT/doc 

Directory
Variables in the File hpeesof.cfg
All IC-CAP programs read the hpeesof configuration file, which 
includes a variety of important configuration variables. The file 
is located in $ICCAP_ROOT/config.

Table 17 Variables in the file hpeesof.cfg

Variable, description, and example Value(s)

HPEESOF_LM_LICENSE_FILE
Complete path to FLEXnet license.lic file.
Example: HPEESOF_LM_LICENSE_FILE = 
{$ICCAP_ROOT}/license/license.lic

Filename

HPEESOF_COLOR
Complete path to system-wide iccolor configuration file.
Example: 
HPEESOF_COLOR={$ICCAP_ROOT}/config/iccolor.cfg

Filename

HPEESOF_FILL
Complete path to system-wide icfill configuration file.
Example: HPEESOF_FILL={$ICCAP_ROOT}/config/icfill.cfg 

Filename

HPEESOF_FONT_FILE
Directory where font index files are located.
Example: HPEESOF_FONT_FILE={$ICCAP_ROOT}/config

Directory
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HPEESOF_OCCIDENTAL_FILE 
Complete path to specify European foreign language fonts. 
(For future use.)
Example: HPEESOF_OCCIDENTAL_FILE= 
{$ICCAP_ROOT}/config/hersh.oc

Filename

HPEESOF_ORIENTAL_FILE
Complete path to specify Asian foreign language fonts. 
(For future use.)
Example: 
HPEESOF_ORIENTAL_FILE={$ICCAP_ROOT}/config/hersh.or

Filename

HPEESOF_LANGUAGE
Specifies the default language.
Example: HPEESOF_LANGUAGE=english

Language 
name

HPEESOF_BUFFER
Size of graphics buffer.
Example: EESOF_BUFFER=5000

Number of 
bytes (0 to 
500K)

HPEESOF_EEHCOPY_FILE
Specifies location where the hardcopy configuration file 
.eehcopy will be written to.
Example: EESOF_EEHCOPY_FILE=home

Location of 
eehcopy:
system
home
cwd (current 
working 
directory)

HPEESOF_EEHCOPY_SETUP
File where you customize the printing of plot files, text files, 
and screen dump files for any system configuration.
Example: 
EESOF_EEHCOPY_SETUP={$ICCAP_ROOT}/config/eehcopy.
setup

Filename

Table 17 Variables in the file hpeesof.cfg (continued)

Variable, description, and example Value(s)
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viewing files, 145

InstallShield
silent installation, 23, 84
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license.lic file
installing, 36
updating, 46, 108

lmgrd, starting, 100
lmpath function, 50
lmtools, using to setup FLEXnet, 27

M
maxuers variable, 146
memory, checking, 16, 77
multiple

disk partitions, 89
IC-CAP versions, 90
vendor licenses, 46

N
nodelock ID, checking, 65
node-locked codeword file, 94

O
operating system

checking version, 13, 75
requirements, 11, 73

options file, creating, 106

P
printers/plotters

ports (UNIX), 131
printing and plotting, 125
printing/plotting

managing printers (UNIX), 129
print setup (UNIX), 126
printing to a file (UNIX), 133, 136
printing to a printer or plotter 

(UNIX), 133
UNIX (overview), 125

R
redundant license servers, 49
response files (See silent installation)

S
security codeword file, 36

select code, 148
server line, 95
setup installation program, 19, 81
silent installation, 23, 84

response file samples, 24, 85
running, 25, 85
troubleshooting, 26, 86
using for uninstalling, 26, 86

starting IC-CAP, 62, 124
verbose mode, 63, 139

support, technical, 69, 151
swap space, checking, 78
system

clock time, 142
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temporary files, recovery, 145
timeout value, 149
troubleshooting

license problems, 140
starting IC-CAP, 138

U
uninstall IC-CAP, 65
UNIX license server, 42
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files, 163
user accounts, configuring, 87
usersimulators file, 169

V
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configuration
customizing, 156
expansion, 160
syntax, 159
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hpeesof.cfg, 180
hpeesofhelp.cfg, 180
iccap.adv, 171
iccap.cfg, 168
setting home environment, 90
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vendor
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